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Legal disclaimer

Alibaba Cloud reminds you to carefully read and fully understand the terms and
conditions of this legal disclaimer before you read or use this document. If you have
read or used this document, it shall be deemed as your total acceptance of this legal

disclaimer.

1. You shall download and obtain this document from the Alibaba Cloud website
or other Alibaba Cloud-authorized channels, and use this document for your
own legal business activities only. The content of this document is considered
confidential information of Alibaba Cloud. You shall strictly abide by the

confidentiality obligations. No part of this document shall be disclosed or provided
to any third party for use without the prior written consent of Alibaba Cloud.

2. No part of this document shall be excerpted, translated, reproduced, transmitted,
or disseminated by any organization, company, or individual in any form or by any
means without the prior written consent of Alibaba Cloud.

3. The content of this document may be changed due to product version upgrades
, adjustments, or other reasons. Alibaba Cloud reserves the right to modify
the content of this document without notice and the updated versions of this

document will be occasionally released through Alibaba Cloud-authorized
channels. You shall pay attention to the version changes of this document as they
occur and download and obtain the most up-to-date version of this document from
Alibaba Cloud-authorized channels.

4. This document serves only as a reference guide for your use of Alibaba Cloud
products and services. Alibaba Cloud provides the document in the context that
Alibaba Cloud products and services are provided on an "as is", "with all faults
" and "as available" basis. Alibaba Cloud makes every effort to provide relevant
operational guidance based on existing technologies. However, Alibaba Cloud
hereby makes a clear statement that it in no way guarantees the accuracy, integrity
, applicability, and reliability of the content of this document, either explicitly
or implicitly. Alibaba Cloud shall not bear any liability for any errors or financial
losses incurred by any organizations, companies, or individuals arising from
their download, use, or trust in this document. Alibaba Cloud shall not, under any
circumstances, bear responsibility for any indirect, consequential, exemplary,

incidental, special, or punitive damages, including lost profits arising from the use



or trust in this document, even if Alibaba Cloud has been notified of the possibility
of such a loss.

5. By law, all the content of the Alibaba Cloud website, including but not limited to
works, products, images, archives, information, materials, website architecture,
website graphic layout, and webpage design, are intellectual property of Alibaba

Cloud and/or its affiliates. This intellectual property includes, but is not limited
to, trademark rights, patent rights, copyrights, and trade secrets. No part of the
Alibaba Cloud website, product programs, or content shall be used, modified

, reproduced, publicly transmitted, changed, disseminated, distributed, or
published without the prior written consent of Alibaba Cloud and/or its affiliates

. The names owned by Alibaba Cloud shall not be used, published, or reproduced
for marketing, advertising, promotion, or other purposes without the prior written
consent of Alibaba Cloud. The names owned by Alibaba Cloud include, but are
not limited to, "Alibaba Cloud", "Aliyun", "HiChina", and other brands of Alibaba
Cloud and/or its affiliates, which appear separately or in combination, as well as
the auxiliary signs and patterns of the preceding brands, or anything similar to
the company names, trade names, trademarks, product or service names, domain
names, patterns, logos, marks, signs, or special descriptions that third parties

identify as Alibaba Cloud and/or its affiliates).

6. Please contact Alibaba Cloud directly if you discover any errors in this document.
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Generic conventions

Table -1: Style conventions

Style Description Example
This warning information
indicates a situation that will Danger:
cause major system changes, Resetting will result in the loss of
faults, physical injuries, and other | user configuration data.
adverse results.
This warning information
indicates a situation that may . Warning:
cause major system changes, Restarting will cause business
faults, physical injuries, and other | interruption. About 10 minutes are
adverse results. required to restore business.
This indicates warning informatio
n, supplementary instructions, Notice:
and other content that the user Take the necessary precautions
must understand. to save exported data containing

sensitive information.

This indicates supplemental
instructions, best practices, tips, Note:
and other content that is good to | You can use Ctrl + A to select all
know for the user. files.

> Multi-level menu cascade. Settings > Network > Set network

type

Bold It is used for buttons, menus Click OK.
, page names, and other Ul
elements.

Courier |Itis used for commands. Runthe cd / d C :/ windows
font command to enter the Windows
system folder.

Italics |Itisused for parameters and bae log list --
variables. instanceid Instance_ID

[] or [a|b] |Itindicates that it is a optional ipconfig [-all|-t]
value, and only one item can be
selected.




Style

Description

Example

{} or {a|b}

It indicates that it is a required
value, and only one item can be
selected.

swich {stand | slave}
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1 Client

This article describes how to use the basic functions of the MaxCompute using client
command line tool. Before using the MaxCompute client, you must install and configure

the client .

Note:

- Do not perform the analysis operation based on the output format of the client.
The output format of the client is not ensured for forward compatibility. Clients of

different versions are different in their command formats and behaviors.
- For more information about basic commands of the client, see Basic commands.
- Click here to download the new version of MaxCompute client.

- The client supports JDK 1.9 from the 0.28.0 version, and the previous version can
only use JDK 1.8.

- The client supports MaxCompute 2.0 from the 0.27.0 version New data type.

After the client is installed and configured, you can use a command line to perform

the following operations.
Get Help
To view the help information of the console, the command format is as follows:
odps @>./ bin / odpscmd - h ;
You can alsoinput h ; or help ;(case-insensitive)in an interactive mode.

The console also provides the help [ keyword ]; command to get the command
prompts related to the keyword. For example, input help table ; toget

command prompts related to the table operation as follows:

odps @ odps > help table ;

Usage : alter table merge smallfiles
Usage : show tables [ in ]
a list of tables | 1s [- p ,- project ]

Usage : describe deserves mention | [.] [ partition ()]


http://docs-aliyun.cn-hangzhou.oss.aliyun-inc.com/assets/attach/119118/cn_zh/1559120057202/odpscmd_public_May.zip

Usage : read [.] [ partition ()] [ line_num ]

Start parameters

When start the console, you can specify a series of parameters as follows:

Usage : odpscmd [ option ]...
where options include :
-— help (- h ) for help
-- project = use project
-- endpoint = set endpoint
-u-p user name and password
-k will skip begining queries and start from
specified position
- r set retry times
- f <" file_path ;"> execute command in file
- e <" command ; [ command ;]..."> execute command , 1include
sql command
- C will display job counters

Take the -f parameter as an example, the operation is as follows:

1. Prepare the local script file script.txt. Suppose that the file is located in the disk D,

and the content is shown as follows:

DROP TABLE IF EXISTS test_table _mj ;
CREATE TABLE test_table _mj ( -id string , name string );
DROP TABLE test_table _mj ;

2. Run the following command:

odpscmd \ bin > odpscmd - f D :/ script . txt ;

Interactive mode

Run the console to directly enter the interactive mode:

[ admin : ~]$ odpscmd
Aliyun ODPS Command Line Too'l
Version 1.0
@ Copyright 2012 Al-ibaba Cloud Computing Co ., Ltd . All

rights reserved
odps @ odps > INSERT OVERWRITE TABLE DUAL SELECT % FROM

DUAL ;

Enter the command at the cursor position (use a semicolon as a statement terminator

), and press Enter to run.



Continuous running

- When using -e or -f option to run a command, if there are multiple statements, and
you want to start running from a middle statement, you can specify the parameter
-k, indicating to ignore the previous statements and to start running from the
specified position. When the parameter <= 0 is specified, the execution starts from

the first statement.

- Each statement separated by a semicolon is considered as a valid statement. The

statements which run successfully or fail to run are printed out at runtime.
For example,

suppose there are three SQL statements in the file /tmp/dual.sql:

drop table dual ;
create table dual ( dummy string );

insert overwrite table dual select count (x) from dual ;

To ignore the first two statements, and start running from the third statement, the

command format is as follows:

odpscmd - k 3 - f dual . sql

Get current logon user
To get current logon user, the command format is as follows:

whoami

Use example:

odps @ hiveut > whoami ;

Name : odpstest @ aliyun . com
End_Point : http :// service . odps . aliyun . com / api
Project : Tlijunsecur -“tytest

Use the preceding command to get the current logon user Alibaba Cloud account,

endpoint configuration, and project name.



Exit
To exit the console, the command format is as follows:
odps @ > quit ;
You can also use the following command to exit the console:

odps @ > q



2 MaxCompute Studio

2.1 What is Studio

MaxCompute Studio is a big data integrated development environment (IDE) tool
that is provided by the Alibaba Cloud MaxCompute platform and installed on the
developer’ s client. It is a development plug-in based on the popular integrated
development platform IntelliJ IDEA, helping users develop data conveniently. This
article describes functional interfaces and common application scenarios of

MaxCompute Studio.
Basic user interface

MaxCompute Studio is a plug-in on the IntelliJ IDEA platform, which shares basic
development interfaces with Intelli] IDEA. For more information about the Intelli]J

IDEA interfaces, see the Interface operation guide.

Based on the Intelli] IDEA interfaces, MaxCompute Studio provides the following

functional interfaces.

- SQL Editor: Provides features such as SQL syntax highlighting, code

complementing, real-time error prompting, local compilation, and job submission.

Compiler View: Displays locally compiled prompts and error messages, and locates

the code in the editor.

- Project Explorer: Connects to a MaxCompute project, and browses table structures,

custom functions, and resource files in the project.

Table Details View: Displays details and sample data of tables, views, and other

resources.

- Job Explorer: Browses and searches for historical jobs of MaxCompute.

- Job Details View: Displays running details of a job, including the execution plan

and details of each execution task.
- Job Output View: Displays output information of a running job.
- Job Result View: Displays the output result of the SELECT job.
- MaxCompute Console: Integrates the MaxCompute client, on which MaxCompute

client commands can be input and executed.


https://www.jetbrains.com/idea/
https://www.jetbrains.com/help/idea/2016.3/guided-tour-around-the-user-interface.html

Connect to MaxCompute project

Before using most features of MaxCompute Studio, you must Create a project connection.
After the project connection is created, you can view related data structures and
resource information in the Project Explorer. MaxCompute Studio automatically
creates a local metadata backup task for each project to increase the access frequency

to MaxCompute metadata and reduce the latency.

Note:

- You must specify the target project connection to modify SQL scripts, submit
jobs, view job information, open the MaxCompute console, and implement other
functions using MaxCompute Studio. Therefore, creating a connection to the

MaxCompute project is necessary.
- For more information about MaxCompute projects, see Project.

- For more information about project management using MaxCompute Studio, see

Project space connection management.
Manage data

You can use the Project Explorer of MaxCompute Studio to quickly browse table
structures, custom functions, and resource files in the project. The tree control can be
used to list data tables, columns, partition columns, virtual views, custom functions,
function signatures, and resource files and types of all project connections. It also

supports fast locating.

You can double-click a data table to open the Table Details View and view metadata,
structure, and sample data of the data table. If you do not have the permission for a

project, an error message is prompted.

MaxCompute Studio integrates MaxCompute Tunnel and supports local data upload and

download. For more information, see Import and export data.
Write SQL scripts
You can easily compile a MaxCompute SQL script on MaxCompute Studio.

1. Open MaxCompute Studio and select File > New > Project or File > New > Module:--.

2. Create a MaxCompute Studio project or module.



3. Select File > New > MaxCompute Script or right-click the menu and select New >

MaxCompute Script , to create a maxcompute SQL script file.

E] Note:

When a MaxCompute SQL script is created, MaxCompute Studio prompts you to
select an associated MaxCompute project. You can also modify the associated
project using the project selector on the right of the toolbar on the SQL editor. The
editor automatically checks metadata (such as the table structure) and reports
errors of an SQL statement based on the project associated with the SQL script.
The editor also sends the SQL statement to the associated project for execution

when it submits the SQL statement for running. For more information, see Compile

an SQL script.

SQL code intelligent prompt

After you enter the code, the SQL editor provided by MaxCompute Studio intelligently
prompts the syntax errors, type matching errors, or warnings of SQL statements, and

marks them on the code in real time. as shown in the following figure.

.key, b.value + c.value

Lrmar — Lraur Lrmar — [EX

table meta.srcp cannot be resolved

By using the code complementing function, MaxCompute Studio prompts you the
name, table, field, function, type, and code keyword of a project based on the code
context, and automatically complements the code based on your selections. as shown

in the following figure.




Compile and submit a job
- Compile a job

Click the m icon on the toolbar of the SQL editor to locally compile an SQL

script. If syntax or semantic errors occur, the editor reports it.

® Information: Parsing ...
® Information: Type checking ...
® Information: Latency.compiler_parse_error : 44170
® Information: Build failed(2)
v El fUsers/xueming.xm/ldeaProjects/MyUDF/Script/scripts
® Error:(9, 15) table meta.table_test cannot be resolved
® Error:(12, 8) table meta.table_test cannot be resolved

- Submit a job

Click the - icon on the toolbar of the SQL editor to submit an SQL script to the

queue of the project specified by MaxCompute.
View history jobs

Open Job Explorer to view recently executed jobs in the specified project.

@ Note:

List only displays jobs submitted by the user ID of the current connection.



MaxCompute Job Explorer

Project

lable| »

EndTime
2017-...

E| lob ID: 20

sta or.. me | EndTime | IP & Path Logld
ADHOC_SINK_3693 #0_0 1/ ' - [2017-... [10.10...
FS: output: MNone

If you have the Log view URL of a job, you can select MaxCompute > Open Logview

from the menu to go to the details page of the job.



Develop a MapReduce program and UDF program
MaxCompute Studio also allows you to develop MapReduce and Java UDF programs.
Connect to a MaxCompute client

MaxCompute Studio is integrated with the MaxCompute Client of the latest version.
Alternatively, you can specify the path of the locally installed MaxCompute client on
the Configuration page of MaxCompute Studio.

On the Project Explorer, right-click a project and select Open in Console to open the

MaxCompute Console window.

a Cloud Computing Co., Ltd. ALL rights reserved.

% 6 TODO »_| Terminal 14 MaxCompute Console A Running Info A MaxCe

Next step

Now, you know the functional interfaces and common application scenarios of
MaxCompute Studio. Continue to the next tutorial. In this tutorial, you will learn how

to install MaxCompute Studio. For more information, see Install IntelliJ IDEA.

2.2 Project space connection management

MaxCompute One of the core features of MaxCompute Studio is to browse resources
of a MaxCompute project, including Table, UDF, and Resource. To realize this feature,

create a project connection first.
Prerequisites

To display Tool Windows of Intelli] IDEA, you must open an Intelli] IDEA project, and
the MaxCompute Project must be configured on Intelli] IDEA using MaxCompute
Project Explorer in Tool Windows. Therefore, before creating a MaxCompute Project
connection, add or import an Intelli] IDEA project. This document uses adding a

project under Windows as an example.
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Open IntelliJ IDEA, click New > Project, select MaxCompute Studio on the displayed

page, and click Next.

Edit View Navigate Code Analyze Refactor Build Run Tools

Project...

VCS Window MaxCompute Help

Invalidate Caches / Restart...

B Print...

Line Separators

Power Save Mode

Exit

3 Java

'3 Java FX

& Android

(" Intelli) Platform Plugin

Additional Libraries and Frameworks:

= Open... Project from Existing Sources...
Open Recent > Project from Version Control >
Close Project Module...
? Settings... Cirl+Al+S Module from Existing Sources...
[ Project Structure...  Cirl+Alt+Shift+S | & Scratch file  Cirl+Alt+Shift+Insert
Other Seftings > zh FXML File
Import Settings...
Export Settings...
Export to Eclipse...
Export to Zip File...
Settings Repository...
FEl save all Ctrl+S
5% Synchronize Ctrl+Al+Y

@uewpoes L=y

1 Maven
(% Gradle

& Groovy
™) Griffon

K Kotlin

"% Empty Project

Mothing to show

E MaxCompute Java

ol MaxCompute Studio

Previous |

| Cancel

Help
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Enter the project name, and click Finish.

MNew Project [==
Project name: MyFirstProject
Project location: | C\Users\Administrator\ldeaProjects\MyFirstProject
¥ More Settings
Module name: MyFirstProject
Content root: ChUsers\Administrator\ldeaProjects\MyFirstProject
Module file location: Ci\Users\Administrator\ldeaProjects\MyFirstProject
Project format: Jidea (directory based) v
Previous Cancel Help

Create a MaxCompute Project Connection

We recommend that you configure the MaxCompute project connection according to

your region strictly. Otherwise, some errors may occur.
Procedure

1. Click view, select Tool Windows.
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2. Click Project Explorer.

roject [C:\Users\wh-wd4192904deaProjects\MyFirstProject] -

Too | Windows

Recent Files
Recently Changed Files
Recent Changes

MNavigate Code Analyze Refactor Build Run Tools VCS Window MaxCompute Help

Cirl+E ¢ Favorites Alt+2
Ctrl+Shift+£ | P Run Alt+4

¥ 'm Project Alt+1

Quick Switch Scheme...

Toalbar
Tool Buttons
Status Bar

<L

MNavigation Bar

Bidi Text Direction

Alt+Shift+C | % Debug Alt+5
. | % TODO Alt+6
Ctrl+

Structure Alt+7
% Version Control Alt+9
# Ant Build
) Capture Analysis
A Capture Tool

> %A Consale

Enter Presentation Mode

Enter Full Screen

Enter Distraction Free Mode

B Designer

@} Event Log
%’ Image Layers

%1 Job Explorer
M Maven Projects
= Palette
= Palette

Project Explorer
Terminal Alt+F12
@ Theme Preview
[# UI Designer

3. Click plus sign + at the upper left corner to add a MaxCompute project.

B MyFirstProject [C:

File Edit View MNavigate Cod

lu_.-w_"‘i- :

e Analyze Refactor Build Run Tools VCS Window MaxCompute

+\ MyFirstProject )

Project Explorer

- 1=

Add P r'D_iE-Et from dataworks

q Add project from accessldfl(eyl

api

Issue: 20190612
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4. In the Add MaxCompute Project dialog box, set configuration options.

Add MaxCompute project | 403 |

Connection | Setting |

nitialize AK Endpoint and other configuration
itemis with odps_config.ini file

Properties File:

AK Account( TO initialize AK with AK account, click on the +
to-add - AK-Account

* Mccess Id:
Configuration-informationsoch-as &K

* Access Key: Endpoint when connecting to MaxCompute
project is required. It can be filled in manually

* Proiect Name: or initialized by the above Properties File or

) ' AK Account,
* End Point:

(7] oK

@ Note:

- Click question mark (?) at the lower left corner of the dialog box to go to the
online document page.

Cancel

- If the synchronization times out, you can consider increasing the time-out
duration for synchronizing metadata to the local host on the Setting tab.
5. After the preceding settings, click OK. Information about the MaxCompute project
is displayed on the left of MaxCompute Project Explorer. You can click Tables,

Views, Functions, and Resources to view tables, views, functions, and resources of
the project.

. o A My )

oject] - Intelli) ILHE!

File Edit View MNavigate Code Analyze Refactor Build Run

Tools VCS Window MaxCompute
+ MyFirstProject

Project Explorer - 20 i
+ - T 007
W

http://service.odps.aliyun.com/api
v TB] MyFirstProjectWdhh
» [g Tables & Views

» EJQ Functions
[ Resources

er ($ Project Explorar)|




View and modify a MaxCompute connection

In MaxCompute Project Explorer, right-click a MaxCompupte project and select Show|
Modify project properties.

MyFirstProject [C:bis 1t ark me rifiris MeaProjects\MyFirstProject] - Intellil IDEA |
File Edit View MNavigate Code Analyze Refactor Build Run Tools VCS Window

+* MyFirstProject |

5 Project Explorer - A0
n -

B+ -0 007

T |v W\ hitpy//service.odps.aliyun.com/api

T Y 3] iy FirstProjectwd .
& > [g Tables & Views Add project ?

> [E@ Functions Remove project

- [ Resources Show|Modify project properties
an

o Refresh meta

3

_",'é Open in Console

- New sqgl editor
Wi

Create a new table

o

o

o

o

=il

]

In the displayed dialog box, you can view or modify connections and settings of the

MaxCompute project.
Subsequent operations

Now, you know how to create and manage a project connection. You can continue to
the next tutorial. In the tutorial, you will learn how to query metadata, clear data, and
upload and download data to manage data and resources. For more information, see

Manage data and resources.

2.3 Tools Installation and version history

2.3.1 Install IntelliJ IDEA
This document describes how to install the basic platform Intelli] IDEA of
MaxCompute Studio.

Context



Procedure

Procedure

1. Click here to download the Intelli] IDEA of the version corresponding to your
operating system (Windows, macOS, or Linux). The following assumes that the
Windows operating system is used.

Download Intelli] IDEA 14.1.4 or a later version. (The Ultimate version, PyCharm

version, and free Community version are supported.)

2. After the download is complete, double-click the installation program to enter the

installation page, and click Next, as shown in the following figure.

’ Intelli) IDEA Community Edition Setup (o || = || &3 |\

I J Welcome to IntelliJ IDEA Community
Edition Setup

Setup will guide you through the installation of Intellil IDEA
Community Edition.

Itis recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer,

Click Mext to continue.

Mext = Cancel



https://www.jetbrains.com/idea/?spm=5176.doc50889.2.1.0ohIYs

3. Specify the installation directory, and click Next, as shown in the following figure.

o

ER Intelli) IDEA Community Edition Setup (o =3 | &= |
Choose Install Location
Choose the folder in which to install Intellil IDEA Community
Edition,

Setup will install Intelli] IDEA Community Editian in the following folder. To install in a different
folder, didk Browse and select another folder. Click Mext to continue.

Destination Folder

rogram Files\JetBrains\Intellil IDEA Community Edition 2018, 1.4

Space reguired: 925.9 MB
Space available: 121.5 GB

[ < Back ]I Mext = I[ Cancel ]

4. Select the 32-bit or 64-bit Intelli] IDEA based on the version of the local operating
system.
You can query the local operating system version by following these steps:
a) Open Windows Resource Manager, right-click Computer and select Properties

from the shortcut menu. as shown in the following figure.

b) In the displayed window, check the type of the operating system.



5. Select the corresponding system type and click Next, as shown in the following

figure.
ER Intelli) IDEA Community Edition Setup o || = | =]
Installation Options
Configure your Intelil IDEA Community Edition installation
Create Desktop Shortout

[] 32-bit launcher [ 4-bit Iauncher]

Create Assodations

O] .java [] .groowy ] ket

<Back || MNext> | [ cancel
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6. Click Install to start installation, as shown in the following figure.

Intelli) IDEA Community Edition Setup o || = | 2]
Choosze Start Menu Folder
Choose a Start Menu folder for the Intellil IDEA Community
Edition shortcuts.

Select the Start Menu folder in which you would like to create the program's shortouts. You
can also enter a name to create a new folder.

JetBrains

Accessories -
Administrative Tools

Cisco

Edipse

Games

Git

Java

Maintenance

Microsoft Office 2013

MySQL-+Front

Motepad ++

Choygen XML Editor 13, 1 (64-bit) -

<Back | Instal | | cancel |

E? Intelli) IDEA Community Edition Setup | =2 || 23

Installing
Flease wait while Intelli] IDEA Community Edition is being

installed.

Extract: bin_togagle_off_focused_holo_dark.9.png... 100%:

< Badk Mext = Cancel
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7. After the installation is complete, click Finish.

ER Intelli) IDEA Community Edition Setup o || = | = |

Completing IntelliJ IDEA Community
Edition Setup

Intelli] IDEA Community Edition has been installed on your
computer.,

Click Finish to dose Setup.

[ Run Inteli] IDEA Community Edition

< Badk Cancel

What's next
Now you know how to install Intelli] IDEA. Continue to the next tutorial. In this

tutorial, you will learn how to install the MaxCompute Studio plugin. For more

information, see Install the MaxCompute Studio plugin.

2.3.2 Installation procedure

Environment requirements

Intelli] IDEA can be installed on Windows, Mac, Linux. For more information about
the hardware and system environment requirements, click here . Intelli] IDEA-based

MaxCompute Studio can also be installed on clients running these operating systems.
MaxCompute Studio has the following requirements on the your environment:

- A client running Windows, macOS, or Linux.
- IntelliJ IDEA 14.1.4 or a later version is installed. (The Ultimate version, PyCharm

version, and free Community version are supported.)

- JRE 1.8 is installed. (JRE 1.8 has been bound to the latest Intelli] IDEA.)


https://www.jetbrains.com/help/idea/2016.3/requirements-for-intellij-idea.html
https://www.jetbrains.com/idea/download/

- JDK 1.8 is installed. (Optional: JDK is required if you need to develop and debug Java
UDF.)

Note:
The client supports JDK 1.9 from the 0.28.0 version. The previous version only

supports JDK 1.8.
Installation method

MaxCompute Studio is a plugin of Intelli] IDEA, which can be installed using either of
the following two methods:

- Online installation using the plugin library (recommended)

- Installation using a local file
Online installation (recommended)

MaxCompute Studio The MaxCompute Studio plugin has been opened for all users on
the Internet. You can install MaxCompute Studio using the official Intelli] IDEA plugin
library.

Procedure

1. Open the plugin configuration page on IntelliJ IDEA. (If you are a Windows/Linux
user, choose File > Settings > > Plugins. If you are a macOS user, choose Intelli]

IDEA > Preferences > Plugins ).
2. Click Browse repositories: - and search for MaxCompute Studio .

3. On the MaxCompute Studio plugin page, click Install.



4. After the installation is confirmed, restart Intelli] IDEA to complete installation.

\dministratar\Local Settings] - Intelli) IDEA ===
Code Analyze Refactor Build Run Tools VCS Window MaxCompute Help
Settings Browse Repositories =
Qr Flugins = | & | category: All
> Appearance & Behavior Q- Show: All plugins + Sort by: name ¥ | FRAMEWORK INTEGRATION
Keymap Sort by: name ¥
> Editor ' Android Support
BT . - cuopor igore
i VCS INTEGRATI
» Version Control = & Bytecode Viewer
= q .NR Null Object
> Build, Execution, Deployment = Copyright U e Homepage | Github | Issues
> Languages & Frameworks ANDROID
& Coverage Features

s Tools 101 Header

CVS Integration « Environment variables completion for
> MaxCompute Studio = 9 4 FORMATTING PHP, JavaScript, Python, Go and Ruby
Eclipse Integration languages
8 1024 Tools ® Dockerfile and docker-compose.yml
& EditorCenfig CODE TOOLS files support
* Goto declaration(in .env file) and
a Git Integration 360 FireLine Plugin 2 ﬁstalges(g? ‘(El‘])dag}bg C1{\()Cmd)+clmk or
ot key(Ctri(Cmd)-B, etc.
& GitHub CODE TOOLS » envfile commenter
- Gradle A Powerful Java Stri R
OBFUSCATION noe
u Groovy env syntax highlighting Go support env.®
A8Translate files support Javascript indexing
a 118n for Java MISC optimization{remove inode_modules fram
. index)
IntelliLang
L]
ABTranslate Vendor
' Java Bytecode Decompiler LANGUAGES
Adel Fayzrakhmanowv
w Java Stream Debugger Aardvark http:ifadelf.
adel.faiz@gmail.com
a JavaFX BUILD
Size
timia = ABACUS Plugin 985K
Check or uncheck a plugin to enable or disable it. FRAMEWORK INTEGF :
Tnstll JetBrain plugin-. [ | S
HTTP Proxy Settings... Manage repositories..

Local installation
MaxCompute Studio MaxCompute Studio can also be installed in a local environment.
Procedure

1. Go to the MaxCompute Studio plugin page to download the plugin package.


https://plugins.jetbrains.com/plugin/9193?spm=5176.doc44555.2.1.4hXBG1
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2. Run Intelli] IDEA.

- If you access IntelliJ IDEA for the first time, a welcome page is displayed. Click
Configure and select Plugins from the shortcut menu, as shown in the following

figure.

] Welcome to In

IntelliJ IDEA

Version 2017.1.5

3¢ Create New Project
1 Import Project
= Open

¥ Check out from Version Control

-3 ConﬁgurE Get Help «

Plugins

Import Settings
Export Settings
Settings Repository...
Check for Update

Project Defaults  »

- If you have accessed Intelli] IDEA before, choose File > Settings > Plugins to

enter the same page, as shown in the following figure.
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Assaciste with Fle Type-..
Bawer Save Made
Exit

Version Control
Build, Execution, Deployment
Languages & Frameworks
Tools

MaxCompute Studio

Vim Emulation

| Show: | All plugins ~ |

< [kisws] » & © = |m Q Csgnin

“a
*a
*a
‘a
“a
“a
“a
*a
*a
‘a
“a
%
“a
*a
‘a
‘a
[

Ant Support

Bytecode Viewer
Copyright

Coverage

CVS Integration
Eclipse Integration
EditorConfig

Git Integration

GitHub

Gradle

Groovy

118n for Java

IdeaVim

IntelliLang

Java Bytecode Decompiler
Java Stream Debugger

lavaFX

Sort by: name ~

]

IEEERNENAANEER EAEAEAAEEAEAE

Android Support

Supports development of Android applications with IntelliJ IDEA
and Android Studio.

Check or uncheck a plugin to enable or disable it.

| Install JetBrains plugin... | | Browse repositories... | | Install plugin from disk... |

| OK H Cancel H Apply
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3. On the Plugins page, click Install plugin from disk---, as shown in the following

figure.
ﬁ
Plugins
a Sho 7]
Sort by: name * | Android Support
Android Support
'f_'é Ant Support gggﬁzio?gvsetlﬁgi?em of Android applications with IntelliJ IDEA
(“a Bytecode Viewer
(“a Copyright
(g Coverage
(“a CVS Integration
(g Eclipse Integration
(g EditorConfig
(g Git Integration
(%, GitHub
(g Gradle
(a Groowy
(g 118n for Java
("g IdeaVim
(“g IntelliLang
(“g Java Bytecode Decompiler
(g Java Stream Debugger
L lavaFX &
Check or uncheck a plugin to enable or disable it.
Install JetBrains plugin... | | Browse repositories... | I Install plugin from disk... I
[ ok ]| cancel
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4. In the displayed window, click the gray icon before a directory for navigation, find

the plugin file, select it, and click OK.

Choose Plugin File @

JAR and ZIP archives are accepted

G " X G & Hide path
& E\Intell) IDEA\odps-studio-intellij-3.0.2_20181126174744.zip | £

functionstudio
jartl
Ksoftware
KwDownload
MCStudicEH
MINIMNT
mysql
Program Files
Program Files (x86)
Users
fedk
BeEiE M

> eclipsef&d

W Intell) IDEA

| odps-studio-intellij-3.0.2_20181126174744.zip

{ L T T . T ¥

2|

I::lu

(1=
1]
=
L=

rop 3 file into the space abowve to quickly locste it in the tree

0 OK Cancel




5. Return to the Plugins page and click OK to install the local plugin.

Settings
|Q- | Plugins
> Appearance & Behavior Q- Show: | All plugins ~
Keymap
3 E,d|tor -] L_,overage
o
> Version Control a Eclipse Integration
> Build, Execution, Deployment a EditorConfig
> Languages & Frameworks m Git Integration
> Tools a GitHub
> MaxCompute Studio & Gradle
Vim Emulation L, Groovy

& 118n for Java

a IdeaVim
a IntelliLang

s Java Bytecode Decompiler
a Java Stream Debugger

a JavaFxX

a JUnit

= Kotlin

& Maven Integration

M

ympute Studio
Check or uncheck a plugin to enable or disable it.

Install JetBrains plugin... Browse repositories...

Sort by: name ¥

Reset

MaxCompute Studio

4}
Ca Restart Intelli) IDEA
MNew version will be available after restart
MaxCompute is a big data processing platform developed by
Alipaba Cloud independently. Itis a fast and cloud-based big
data solution that supports multiple distributed data storage
and processing models, which can provide massive data
warehouse and big data modeling service.
MaxCompute Studio is a plugin for IntelliJ platfiorm allowing
data developers works with MaxCompute platform including
authoring SCL scripts, UDF extensions, MapReduce
programs and other functions like local debugging, data
browsing and uploading/downloading, job browsing and
analytics, etc.
Features include:
» MaxCompute SQL language support
» MaxCompute function development
* MaxCompute data management
» MaxCompute job management
Change Notes
Changes in Version 3.0.0:
* MNew Feature:
» support write authorization statement, show user

privileges and diagnosis auth exception message
& use webview to draw sql pot graph and performance

Install plugin from disk...

Cancel Apply
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6. After the installation is complete, a dialog box is displayed, prompting you to
restart Intelli] IDEA. Click Restart.

I Restart I| Postpone |
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7. After Intelli] IDEA is restarted, the page is displayed as shown in the following

figure.
Bl Mylmmmaiomct (€ y pearale : Ayl ¥ 17] - Intelli) IDEA (Administrator)
Fle Edit VWiew MNavigate Code Analyge Refactor Build Run Tools VCS Window MaxCompute Help
A
g | Project Explarer n =
£y —
El+ - OE%S % £ OO 7
- —
| ¢ ¥ htpe e sl seeaapi
%
E‘ B Tip of the Day
Tha shortouts such as Ctrl+g (View | Quick Documantabion], Ctrlsp (View |

¥ Parameter Info), Ctr1+6 (Navigate | Dedaration) and others can be used not only in
k- the editor but in the code completion popup list as well.
g
| catchi{lUnsl
et @ & UnsatisfiedLinkError (java.lang) "

4 ‘6 UnsupportedLockindFeelException

Documentation for UnsatisfiedLinkError 4

¢ < 1l7> %

javalang

public class java.lang.UnsatisfiedLinkError

extends jawn.lang.LinkpgeErsor

[7] Show tips on startup Previous Tip Close
-
3
o]
=
@
Next step

Now, you know how to install the MaxCompute Studio plugin. Continue to the next
tutorial. In the tutorial, you will learn how to configure a MaxCompute project
connection to manage data and resources. For more information, see Create a

MaxCompute project connection.

2.3.3 View and upgrade the version
View the MaxCompute Studio version
Perform the following steps to view the Studio version:

1. Go to the Settings/Preferences page (by pressing Ctrl - Alt - S in Windows or
32 in macOS).

2. Select Plugins on the left bar of the dialog box and search for MaxCompute Studio.

3. View the MaxCompute Studio version number and release information.

Alternatively, you can select MaxCompute Studio on the left bar of the Settings page

to view the current version number.



Check new versions

By default, MaxCompute Studio automatically detects new versions. If a new version

is available, MaxCompute Studio automatically notifies you.
After receiving an update prompt, you can select:

- Install: Click the Install link in the update prompt. The new version is
automatically downloaded and installed. After the installation is complete, restart
Intelli] IDEA.

- Configure: Click the Configure link in the update prompt. You can configure

whether to detect new versions automatically.

If the automatic update function is disabled, you can perform the following steps to

check and install a new version of MaxCompute Studio.

1. Go to the Settings/Preferences page (by pressing Ctrl - Alt - S in Windows or
$2 in macOS).

2. Select MaxCompute Studio on the left bar of the dialog box.

3. On the MaxCompute Studio configuration page, click Check new versions.

4. If a new available version is detected, Studio notifies you of the new version

number. Click Install new version and restart Intelli] IDEA to complete

installation.

You can use the Automatically checks for new version check box to control the switch

for automatic version update check.

Next step

Create a MaxCompute project connection

2.4 Manage data and resources

2.4.1 View tables and UDF

View tables and functionsView tables and functions

In the Project Explorer window, you can view tables, functions, and resources with
connections added. For tables and functions to be viewed in the Project Explorer
window, the MaxCompute project connections must be added, for more information,

see Add MaxCompute project connections.



Browse tables and functions
To browse tables and functions in the project space, follow these steps.
1. Open the Project Explorer window and you can view the added Project node tree.
‘MaxCompute Project Explorer
+ - 0O 2= OO ?
Pl

[H Tables & Views
[~ ] Functions
[ Resources

The toolbar is displayed at the top of the node tree, and includes:

- Add Project: Adds a connection to the MaxCompute project space.

- Delete Project: Deletes a connection from Project Explorer, which has no impact

on the project space on the server end.

- Update Metadata: Updates metadata information from the project space on the
server end and updates the locally buffered metadata.

- Expand Node: Expands all tree nodes.

- Fold Node: Folds all tree nodes.

- User Feedback: Submits user feedback.

- Online Documentation: Opens online documents.

2. Double-click the Tables node or click the drop-down arrow to expand the Tables
node to list all tables in the project (including virtual views). The table name list
serves the same purpose as the show tables command. You must have the List
Table permission in the project. The methods for the Functions and Resources

nodes are similar to that of the Tables node.

P] odps_studio_dev
B Tables & Views B
#H alitrip_dest_relation
tHH array_map_test2
+H haoping_sdk_log_copy
+H haoping_test_part
HH hy_testl
HH key
it table test
[~ Functions
ITTResourcesl|




3. MaxCompute Studio downloads project metadata on the server to the local device
. When metadata on the server end is updated, for example, a new table is added,
you must manually trigger a refresh to reload changed metadata to the local device
. The refresh can be performed at the Project or Table level. The procedure is as

follows:

a. Select a node.

b. Click the Refresh icon on the toolbar or right-click the node and select Refresh

meta.

MaxCompute Project Explorer - A\

+-[g]lz=z 002
?E odps_studio_dev
;?Ebles = Add project

EHEH alitri
EEPS | Refresh meta |

haop open specific entity
haoping_test_part
hy_testl

View table details
You can view data table information in Table Details View of MaxCompute Studio.

1. In the node tree, expand a table node to view the column name and type.

[P odps_studio_dev
@ Tables & Views
i+ alitrip_dest_relation

| -
OOy T

| 1 20 P e
|

i id :STRING
arrays :ARRAY <STRING=

. maps :MAP<STRING,STRING >
H haoping_sdk_log_copy

+ haoping_test_part
HH hy_testl

- key

iHH table_test

[~ ] Functions
FE Resnurces




2. Double-click a table or right-click a table and choose Show Table Detail to view the
table details. The table details include metadata, such as owner, size, and column,

table structure information, and data preview.

#- 1= & JavaMethodr. njava x  [g Plushelloclass x  5b_hour x
Table information Table schema
me type mmer
6] a_0101020223_stgcontrol_395 b_hour hous gs::g
F] studiotest1_testl <
1830820614534790 d STRING
[ Tables & Views 2016-02-18 15:20:46 e STRING
2016-04-18 16:48:18 3 STRING
[ hour :STRING 2016-08-05 10:18:33 q STRING
E c STRING 63048 h STRING
[ d :STRING 189144
[ e STRING
[ fSTRING
[ g STRING
[ h STRING
Data preview
n a i a n
00 o gl | | gl | |
o1 o o] o o] m
02 o] o o o m
03 o f o | g rull | g il | g rull |
04 o] o] o o] o
05 o f o | o il e
06 o] o] o o] o
07 o f o | o il e
08 o o o o] e
09 o o g rull | g il | g rull |
10 o o o o] o
11 | | | | |
12 o o o o] m
13 | o o} | o]
14 o o o o] m
15 | o o} | o]
16 o o] o o] e
17 o o] o o o
18 o o] o o] m
19 T o | T o]

3. Right-click Tables & Views and select Open specific entity to display the details
of the specific table. Note that the complete table name must be specified. If you
do not have the List permission on the project and only have the permission on
a specific table, you can also view details of the table using this method. The
methods for the Functions and Resources nodes are similar to that of the Tables

node.

MaxCompute Project Explorer
+ -0 X O®O?
?E odps_studio_dev

Func Add project
» [ZIResc Refresh meta

1P pr—d Open specific entity

?E studiotest]_testl

o Open specific table %

Name:|| I

o JEEey

Intellij IDEA supports searching by default. After a table is expanded, you can

directly press keys on the keyboard to perform fuzzy match.



4. MaxCompute Studio also supports quick search for the table, you can use the
shortcut key (Windows: Ctrl + Alt + Shift + N, macOS: # + 3£ + O) to call the

navigation bar, then enter the name of the table and press Enter.

Enter symbol name: Include non-project symbols (\X$0) T

Q_hyl

o)

hy_partition_test odps_studio_dev

hy_view odps_studio_dev

m_test odps_studio_dev

You can narrow the search by using the pre-keyword (table:, function:, or resource

:). For example, to search for the function count, enter function:count.

5. To know the scripts in which the table is used, right-click the table and select Find

usages.

BT " F e el el e

Hhy testl  Add project
| hy_test2 Find usages

= hy_Vi ew
HH my_part_

Refresh table meta

View function details

1. Expand a function node under the UserDefined node of Functions to display
the method signature of this function. Double-click a function node under the

Functions node. Alternatively, double-click the source code resource of the




function under the Resources node. In this case, codes of this function are

displayed.
4  MaxCompute Project Explorer - T L JavaMethodFunction. java x of PlusHello.class x
> + - l‘ L N 3 q ¥ n
i : g = T Decompiled .class file, bytecode version: 50.0 (Java 6)
;' F] meta_dev 1 ) B -
tIE a_0101020223_stgcontrol_395 g /{ Source ccf‘e riLeJCef .:,-ECJ L;cc file by Intelli] IDEA

v v {P] studiotest]_testl 2 om T
g ['E Tables & Views 5
H [F Functions 6 package myudf;
: - 7
-l x divideerror . )
™ £ 8 import com.aliyun.odps.udf.UDF;

fx myudtf 9

fxm 1@ public class PlusHello extends UDF {
g fx plushello(STRING):STRING 1 public Plushelle() {
- Jx timestwo .‘g }
g 1
- URESOUTCES 14 public String evaluate(String a) { return "hello" + a; }
;—‘» 17 }
£ 18

Note:

The Java code is obtained by decompiling JAR, which is not the source code. To
enable the Python UDF to parse the signature, install PyODPS (MaxCompute
Python SDK) first. Install pip : sudo / usr / bin / python get - pip

. py (Download get - pip . py from Google manually) and then PyODPS

sudo / usr / bin / python - m pip install PyODPS . Note that
the Mac operating system has Python, which is stored in /usr/bin/python. Install
PyODPS in this directory.
2. The classification under the BuiltIn node of Functions shows the built-in
functions of the system, expand it to display signature and double-click it to

display function document.

2.4.2 Import and export data
MaxCompute Studio can import local data files in CSV or TSV format to MaxCompute
tables and export MaxCompute table data to local files. MaxCompute Studio
completes data import and export by using Batch data Tunnel provided by the

MaxCompute platform.
Usage instructions

- The MaxCompute Tunnel service must be used for data import and export.
Therefore, the MaxCompute project added in Studio must be configured with the

Tunnel service.

- Related permissions must be granted for table import and export.
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Import data

1. Open the Project Explorer window, right-click a table name or a field attribute in

Data preview of Table details and select Import Data Into Table.

File Edit View MNavigate Code Analyze Refactor Build Run Tools WVCS Window

% Local Settings

Project Explorer - A0

+ - ORES ¥ T OO ?
w Y4 http://service.odps.aliyun.com/api
v P] MySecondProject2
v [ Tables & Views
> [E bank_data

E emp_test_new

FH ods_user info_d

r'EsuIt_t' '
EH result | Q STIUEIIE
i table__l 5 User Privilege

»

>

»

»

>

> H W‘f_l.nl [T Refresh table meta
> [f Functions | 55 o1y table detail
> [ Resources

5] Open table editor

Generate select statement

Generate DDL statement

Truncate table data
(=) Drop table from server

Import data into table

Export data from table
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2. In the Import Data dialog box that appears, select the path of the imported data
file, column separator, size limitation, and number of lines for an error tolerance,
and click OK .

?E odps_studio_dev
lﬁles & Views

i alitrip_dest_relation
rray_map_test2

[ Functi Show table details

[T Resou

“]’E wpp_dev Delete table from server

?ﬂ_ cdo_meté Generate select statement

{P] studiotes, -
| Import data into table |

Export data from table

3. If Import Data Success is displayed, data import is successful and imported data

can be viewed in the table.
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Export data
1. Two methods are provided for table data export.

- Right-click a table name and select Export Data From Table.

+ - OERYS * LT OO ?
v Y hitp://service.odps.aliyun.com/fapi
v P] MySecondProject2
v [& Tables & Views
> [ bank _data
Eemp_test_new
[Hlods_user info
EH result_tabl Q Find usages

>

>

>

> [ result_table $ User Privilege

; %t&bl:e_ll [T Refresh table meta

we_in .

> P2 Functions @l Show table detail
> [ Resources ] Open table editor

Generate select statement

Generate DDL statement

Truncate table data
() Drop table from server

Import data into table

Export data from table

- Right-click a field attribute in Data Preview of Table details and select Export

Data From Table.

shy_testl % |

Table information : Table schema

key value E name type comments

Name: hy_testl i lid BIGINT
Comments: 2| [name STRING
Qwner: ALIYUNSdxp_06894684@aliyun.com | |ace BIGINT
Created time: 2016-12-29 11:50:22 g

Meta Modified time: 2016-12-29 11:50:22 |

| Data Modified time: 2017-01-22 20:42:37

Size: 1280

| Physical size: 840

| Partitions: o

| Partition columns

| Sharding:

| Sharding columns:

aw

Data preview
‘1 id Export data from table

Import data into table
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2. In the Export Data dialog box that appears, select the path for saving the exported
data file, column separator, size limitation, and number of lines for an error

tolerance, and click OK.

+ - 0 = OD ?
?E odps_studio_dev
[@Tables & Views
] alitrip_dest_relation

[

rray_map_test2

e Add project

i tal Refresh table meta

[~} Functi
fxadc
fx ex2 Delete table from server

Show table details

frhac Generate select statement
fx hac
fx hell Import data into table

EEsEl Export data from table

Ry

3. If Export Data Success is displayed, data export is successful and exported data can

be viewed in the target file.

You can also right-click Data Preview of Table and choose Export Grid Data to export

data.
ahy testl x
Table information : Table schema
key value name type comments
Name: hy_testl id BIGINT
Comments: name STRING
owner: ALIYUN$dxp_06894684@aliyun.com age BIGINT
Created time: 2016-12-29 11:50:22
Meta Modified time: 2016-12-29 11:50:22
Data Modified time: 2017-01-22 20:42:37
Size: 1280
Physical size: 3840
Partitions: 0
Partition columns
Sharding:
Sharding columns:

o, SR,

Data preview

1 a 11
1

Copy cell content

Export grid data

View cell text

@ Note:

The Data Preview function in Data preview is used only to export data displayed in

Data sample instead of all data in the table.
New Type Import Export

Simply generate text in the agreed format and store it in CSV or TSV format, you can

import to table through studio.

Conversion rules for each data type are described in detail below.




Basic Type

1.

N s o0 e

9.

Tinyint, smallint, Int, bigint is stored directly as an integer string, and the numeric

value exceeds the type boundary is reported as wrong

. Float, double to store fractional strings or floating-point forms, such as: 2.342 1x +

7

Varchar is stored directly as a string, which is automatically truncated above the

upper limit, and no errors will be reported

String is stored directly as a string

Decimal string that supports shaping or floating-point
Binary needs to encode binary data to base64 string

Datetime date time requires that the format specified in import dialog is consistent

and that the format mismatches will be reported incorrectly

. Timestamp timestamp needs to follow yyyy-[m] M-[d] d hh \: mm \: ss [. f...] Format

is stored as a string

Boolean true or false string?

Composite Type

1.

Array needs to be stored as a JSON array. The array elements are converted to
strings according to the rules agreed in this article, array elements support any
type.

Map needs to be stored as a JSON object, and map key, value are converted to a
string according to the rules agreed in this article, value supports any type of

nesting.

. Struct needs to be stored as a JSON object, the struct field name is string, and the

key converted to a JSON object, strect field values converted to JSON The value of

the object, the value of the field that defines the rule transformation in this article.

Example

Array type

For Table structures as follows:

Column name Column data types
c_1 ARRAY<TINYINT>
c_2 ARRAY<INT>

c_3 ARRAY<FLOAT>




Column name Column data types

c_4 ARRAY<DATETIME>
c_6 ARRAY<TIMESTAMP>
c_7 ARRAY<STRING>

You can import data in the CSV format shown below:

c1l,c2,c3,c4d4,c6,cT
H[H n l n H’H n 2 HH, n 3 n H]H, H[H l HH, n 2 H’ n 3 H’ n 4 H],
H[H n l . 2 n H’H 2 . G HH] H’ H[H n 3 — GO : Oo : OO H, n 3 —
5-00 : 00 : 00 "", "QEO : 00 :00", "[" At 00 : 00 : 0O .
123456789 "', " At 0 : 00 : 00 . 123456789 "", " At 00 : 00 :
Oo . 123456789 HH] H,H [H AAA n H’H Steamboat HH, n 4C n H]H
H[HH l HH’HH 2 HH’HH 3 HH]H’H[HH l HH’HH 2 HH’HH 3 HH’HH 4 HH]H’H[HH l
. 2 HH’HH 2 . 0 HH]H’H[HH 2@17 —_ ll _ ll GO : OO . OO HH’HH 2@17 —_
11 - 11 0 : 00 : 60 "","" 2017 - 11 - 11 00 : 0O : O ""m,m"[""
2017 - 11 - 11 00 : 00 : 00 . 123456789 "","" 2017 - 11 - 11 00
: 00 : 00 . 123456789 "","" 2017 - 11 - 11 00 : 00 : 00 . 123456789
HH]H’H[HH aaa HH’HH bbb HH’HH ccc HH]H
H[HH l HH’HH 2 HH’HH 3 HH]H’H[HH l HH’HH 2 HH’HH 3 HH’HH 4 HH]H’H[HH l
. 2 HH,HH 2 . O HH]H,H[HH 2017 — ll — ll OO 0 OO 0 OO HH,HH 2017 _
11 - 11 0 : 00 : 60 "","" 2017 - 11 - 11 00 : 0O : @O ""Im,m"[""
2017 - 11 - 11 00 : 00 : 00 . 123456789 "","" 2017 - 11 - 11 00
: 00 : 00 . 123456789 "'","" 2017 - 11 - 11 00 : 00 : 00 . 123456789
HH]H,H[HH aaa HH,HH bbb HH’HH ccc HH]H

Note:
The CSV format needs to escape double quotes, which are expressed by two double

quotes, you can refer specifically to the CSV format specification.

Map Type

For Table structures as follows:

Column name Column data types

c_1 MAP<TINYINT,STRING>
c_2 MAP<STRING,INT>

c_3 MAP<FLOAT,STRING>

c_4 MAP<STRING,DATETIME>
c_5 MAP<STRING,STRING>

c_6 MAP<TIMESTAMP,STRING>

You can import data in the CSV format shown below:



:H n 2345 n "}”’ H{" 123 "": n 2 ", n 3 ”: n 4 ”"}H, "{ 2 .

:H n 223445 n H’ l . 2 :H llll HH}H’ H{H n AAA n H:H n hubll

00 : 60 : @@ "', " 4C " ":" China " 11 00 : 00 : 00 " ",
Steamboat "": " 00 : 00 : 00 "} "," ckey "": " cvalue "} "," {""
hubll 01 : 00 : 00 . 123456789 "": " dddd " "," " hubll 00 :
00 : 00 . 123456789 "": " AAA " "," 027 11 00 : 01 : 0O .
123456789 "": " DDD ""}"

H{ l :H n 2345 n H}H, H{" 123 HH: n 2 "’ n 3 H: n 4 HH}H’ H{ 2 .

O :" n 223445 n "’ l . 2 :" llll "H}", ”{" n AAA n ”:" n hubll
00 : 60 : @@ "", " 4C " ":" China " 11 00 : 60 : 0 " ","
Steamboat "": " 00 : 00 : 00 "} "," ckey "": " cvalue "} "," {""
hubll 01 : 00 : 00 . 123456789 "": " dddd " "," " hubll 00 :

00 : 00 . 123456789 "": " AAA " "," 027 11 00 : 01 : 0O .
123456789 "": " DDD ""}"

H{ l :H” 2345 H”}"’”{"H 123 H":”H 2 H"’”H 3 H":”H 4 H"}”,"{ 2 . 0 :”H
223445 "", 1 . 2 :"" 1111 ""}" "{"" aaa "":"" 2017 - 11 - 11 00 :
Oo : OO "H,"" CCC ”":H” 2017 — ll — ll OO : OO : OO ”",H” bbb "H:""
2017 _ ll — ll 00 : 0@ : @0 HH}H’H{HH Ckey HH:HH Cvalue HH}H’H{HH
2017 - 11 - 11 01 : 00 : 00 . 123456789 "":"" dddd "","" 2017 - 11
- 11 00 : 00 : 00 . 123456789 "":"" aaa "","" 2017 - 11 - 11 00 :
01 : 00 . 123456789 "":"" ddd ""}"

c1,c2,c3,c4,c5, c_6
H{ l
0]

Struct Type

For Table structures as follows:

Column name Column data types

C_struct <RUCT<x:INT,y:VARCHAR(256),7:
STRUCT<a:TINYINT,b:STRING>>

You can import data in the CSV format shown below:

c_struct

H{FH X HH:HH 1000 mnmmn mnmn y HH:HH VarChar te St mnn mnmn z HH:{HH a HH:HH
123 HH’HH b HH:HH S%ringdemo HH}}H - ’

H{HH X HH:HH 1000 HH’HH y HH:HH VarChar te St HH,HH Z HH:{HH a HH:HH
123 HH’HH b HH:HH Stringdemo HH}}H -

2.4.3 Visualization of operating the tables
The Project Explorer of MaxCompute Studio provides the visualized table structure

editor used to create and modify tables.
Visualization of creating a table

Procedure



MaxCompute Tools and Downloads / 2 MaxCompute Studio

1. Right-click the project that you want to create the table, and select create a new

table.
Project Explorer - A
+ - DRSS ¥ £ OO 7

w A http:/fservice.odps.aliyun.com/api
v TP] MySecondProject2

Tables 8 View
» [ bank data
> E emp_test_n
» [ ods_user |
3 [ result_tabl
> [ result_table
> [ table 1

» B wecinl

m Functions
Resources

Open specific entity
[7 Refresh meta

= new table

3
2
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2. In the dialog box that appears, enter a table name and column information. Click
Generate CreateTable Statement generates the corresponding pant statement,

click Execute to execute the build table.

Create Mew Table/View - [MySecondProject2] @
Create Table: [Tf not existsy_|Externall [View
Comment: o
Lifecycle: ] Days

[ J5tored as AliQrc [ Like Table

Partitinns Indices| A5 SELECT | Table Properties

e narme type not null comment +
id BIGINT --

sqLooL scrieT | )

CEEATE TABLE “MySecondProject2™.”" |
*id® BIGINT)

|@

Actions:| Execute on MaxCompute Service ™ Cancel

When you set the table name, column name, type, and lifecycle, observe the

related requirements of MaxCompute. For more information, seeTable operations.

3. After the table is created, view the table metadata in table&view of the Project

Explorer. If no metadata is displayed, refresh the list.
Visualization of modifying a table

Procedure



1. Intable&view of the Project Explorer, right-click the expected table and select
Open table Editor:

Project Explorer 8- -

+ - ORS ¥ T OO ?
~ Y4 hitpy//service.odps.aliyun.com/api
v TP] MySecondProject2
v [ Tables & Views

Q| oank dat RS uEra—

> emp_test_ne ~ -

» ods_user_inf| =¥ User Privilege

> result_tabl .[__j" Refresh table meta

> [ result_table | .

— - 1 Show table detall

» table_1 LR B

» we_inl Open table editor
> [ Functions Generate select statement
> [ Resources

Generate DDL statement

Truncate table data
(=) Drop table from server

Import data into table

Export data from table

2. In the dialog box that appears, edit the table. You can modify the table comments,

table lifecycle, column name, and column description, and add columns. Specific



rules follow the MaxCompute table requirements and can be found inTable

operations.
fERE= - [MySecondProject2.table_2] |E|
== table_2 (A
R
e -1 =

2EERl | oXP | F3|| HWinEE

name type not null comment +
coll BIGINT
col2 BIGINT
cold BIGINT
col3 BIGINT
col3 BIGINT

SQL DDL SCRIPT

ALTER TABLE table 2 ADD COLUMNS ¢ 2
col5 BIGINT).
B 5558 MaxCompute #1147 v | SiEESEEE ~ Elig T

3. After completing the modifications, click Alter Table Statement Generate a specific
alter statement and click Executeto perform the table modify operation. After

successful execution, view the table metadata.
Visualization of deleting a table

In table&view of theProject Explorer, right-click the expected table and select Drop

table from server:



Project Explorer 8- -

+ - OE%S ¥ £ OO ?
~ Y4 hitpy//service.odps.aliyun.com/api
v TP] MySecondProject2
v [ Tables & Views
» bank_data
emp_test_new
ods_user_info_d
result_tabl
result table

£ .
table 2 Q Find usages
we_inl 5 User Privilege

>

>

>

>

>

>

>
b Eﬁ Functions f_j‘ Refresh table meta
> (AR : i
ESOUrCes ﬁ] Show table detail

Open table editor
Generate select statement

Generate DDL statement

Truncate table data

Drop table from server

Import data into table
Export data from table

Select OKin the bullet box to remove the table from the MaxCompute service.

2.5 Develop SQL procedure

2.5.1 Create MaxCompute Script module

Before developing MaxCompute Script, you need to create a MaxCompute Script

module in either of the following scenarios:
No script file exists locally
If no script file exists locally, you can use Intellij IDEA to create a new module.

Procedure



1. Open or create a MaxCompute Studio project. This article uses creating a project
as an example. Click File in the menu and select New > Project . as shown in the

following figure.

Local Settings [CA\Users\AdministratorLocal Settings] - C\Users\AdministratorIdealC
Edit View MNavigate Code Analyze Refactor Build Run Tools WVCS Wind

COpen.. Project from Existing Sources...
Cpen Recent Project from Version Control #
Close Project Module...

- Settings... Ctrl+Alt+5 Module from Existing Sources...

i Project Structure... Ctrl+Alt+Shift+S | g Scratch File Ctrl+Alt+Shift+Insert
Other Settings ¥ =% FXML File

Import Settings...
Export Settings... :
Export to Eclipse... 7
Export to Zip File...

Settings Repository...

Save All Ctrl+5
Synchronize Ctrl+Alk+Y
Invalidate Caches / Restart...

ggj i

Print...

Power Save Mode

Exit
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2. Select MaxCompute Studio on the left-side navigation pane, and click Next.

Mew Project @

2 Java Additional Libraries and Frameworks:

= Java FX
lil Android
Intelli) Platform Plugin

7 Maven MNothing to show

(=} Gradle

& Groovy
™ Griffon
K Kotlin

& Empty Project

+% MaxCompute Java
MaxCompute Studio

I Mext I | Cancel | | Help
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3. Enter the project name, and click Finish.

o

MNew Project 2

Project name:  |MySQLProject

Project location: | Ch\Users\Administrator\ldeaProjects\MySQLProject

b More Settings

Previous Cancel Help

@ Note:

If a project has been opened before, a dialog box appears, prompting whether to
open the new project in the existing window (closing the previous project). Click

This Window.

-

Mew Project £2

E' Mew projects can either be opened in a new window or replace the project in the existing window.
How would you like to open the project?

[] Remember, don't ask again This Window MNew Window
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4. After the project is created, the page shown in the following figure appears. You

can develop SQL scripts in the project.

B MySQLProject [CA\Users\Administrator\IdeaProjects\MySQLProject] - Intelli) IDEA
File Edit View Mavigate Code Analyze Refactor Build Run Tools VCS Window MaxCompute He
& MysQLProject

7 Project - (I - 2 o
> @MYSQLProjecI ChUsers\ddministrator\ldeaProjects

Il External Libraries
» [ Scratches and Consoles

Script files exist locally

If many scripts have been stored in a local folder, MaxCompute Studio is used to edit

the scripts. You can open a module directly.
Procedure

1. Create a connection configuration file odps_config.ini for MaxCompute in the scripts

folder, and configure authentication information for connecting to MaxCompute.

* project_name=xxxxxxxx
- access_id=XXXXXXXXXX
- access_key=xxxxxxxxx

- end_point=xxxxXxxxxx

Issue: 20190612 51



2. Open Intelli] IDEA, select File > > Open, and select the scripts folder.

Open File or Project 22 ]
- 2 X | | = Hide path
CA\Users\Administrator\ldeaProjects |;|
> Documents
> Downloads
> eclipse-workspace
> Favorites

W IdeaProjects
v g MyfirstProject
> idea
> gMyFristModule

v [igscripts

v Jidea
= modules.xml
m SCripts.iml
= workspaceml
> target
> warehouse

o WlyfirstProject.iml

file into the space above to quickly locate it in the tree

L]
M
[ =]
w
[=1
[=]
T
w
T

0 OK Cancel

3. MaxCompute Studio detects whether the odps_config.ini file exists in the folder,
captures metadata on the server based on the configuration information in the file,

and compiles all scripts in the folder.

2.5.2 Write SQL

Table operations

2.5.3 Submit SQL scripts

MaxCompute Studio directly submits MaxCompute SQL scripts to the server for
running, and displays detailed information about the query result and execution
plan. Before submission, MaxCompute Studio compiles scripts to effectively prevent

compilation errors that are detected after the scripts are submitted to the server.
Prerequisite

- Create a MaxCompute project connection and bind it to the target project.



- Create a MaxCompute Studio module.

- Before submission, perform setting as required. MaxCompute Studio provides
various setting features. You can perform quick setting on the toolbar at the top of

the editor page. The following three types of setting can be performed:
- Compiler Mode: It can be set to Script Mode or Statement Mode.

B In statement mode, scripts are separated by ; and submitted to the server one
by one.

B The script mode is newly developed. A whole script can be submitted to the
server immediately. The server provides overall optimization, which is more

efficient. Therefore, this mode is recommended.

- Type System: It mainly solves the compatibility problem of SQL statements,

which can be set to the following values:

B Legacy TypeSystem: Indicates the type system of original MaxCompute.

B MaxCompute TypeSystem: Indicates the new type system introduced by
MaxCompute 2.0.

B Hive Compatible TypeSystem: Indicates the type system in Hive compatibility
mode introduced by MaxCompute 2.0.

- Compiler Version: MaxCompute Studio provides the stable compiler and

experimental compiler.

B Default Version: Indicates the stable version.

B Flighting Version: Includes the latest features of the compiler.

Note:
You can use Global Settings to set the submitted scripts. Select File > > Settings
> > MaxCompute , select MaxCompute SQL, and choose Compiler > > Submit

to set the preceding attributes.

Submit SQL scripts

The top toolbar of the editor provides the Synchronize and Compile and Submit

features.

* *x Synchroniz e **: Updates metadata in SQL scripts ,
including  table names and UDFs . If MaxCompute Studio
prompts that a table or function cannot be found ,
but the table or function obviously exists on the
server , you can use this function to update metadata



* *x*% Compile and Submit **x: SQL scripts are compiled
or submitted to the server in compliance with pre -

released MaxCompute SQL rules . Details of compilatio n

errors are displayed in the *x MaxCompute Compiler #*x*
window .
Procedure

1. After SQL statements are compiled, click the green running icon on the toolbar,
or right-click Script Editor and select Run MaxCompute SQL Script to submit
the SQL statement to the server. If a variable exists in the SQL statement (such as
${bizdate} in the following figure), a dialog box is displayed, prompting you to enter
the variable value.

2. The script will be locally compiled (depending on the project metadata you added
in the Project Explorer window). If no compilation error exists, the script is
submitted to the server for execution. When the SQL script is being executed,
the running logs are displayed. If the script is running on the server, the Job
Details page is displayed, showing the basic information about job running and the
execution diagram.

3. You can view SQL results on the Results page. If there are multiple statements in
the single-sentence mode, the result of each statement is displayed. You can select

rows or columns in the table, and copy them to the Clipboard.

2.6 Developing Java

2.6.1 Create MaxCompute Java Module
MaxCompute Studio supports Java user-defined function (UDF) and MapReduce

development. First, a MaxCompute Java module must be created.
Create a module

ChooseFile > New > Module, set the module type to MaxCompute Java , and
configure Java JDK . Click Next, enter a module name, and click Finish.
MaxCompute Studio automatically creates a Maven module and introduces

MaxCompute dependencies.
Module structure

So far, a module for developing a MaxCompute Java program has been established,

that is the mDev shown in the following figure. Its main directories include:



- src/main/java: Source code for Java program development.
- examples: Sample code, including unit test (UT) examples. You can see the
examples to develop or compile UT.

- warehouse: Schema and data required for running locally.

B Project ~ 0 = | 8- I+
vt MyfirstProject C:\Users\Administrator\ldeaProjects\M
b Jdea
v MyFristModule
» examples
v Src
W main
b java
resources
> test
» target
m MyFristModule.iml
pom.xml
b scripts
target
w warehouse
v example_project
> __FESOUrces__
w __tables__
b ads_log
¥ kmeans_in
¥ kmeans_out
b pagerank_in
b pagerank_out
? rs_out
b 555p_in
? sssp_out
¥ we_inl
¥ we_in2
? we_out
m MyfirstProject.iml
» |l External Libraries
» [ Scratches and Consoles




2.6.2 Develop and debug UDF

Once the MaxCompute Java Module has been created, udfs can be developed.

Procedure

1. Expand the MaxCompute Java Module Directory that you created and navigate

to src > main > java > new, and click MaxCompute Java as shown in the following

figure.
v MyfirstProject ) [ scripts ) 2] MyFirstSQL.osgl »
&7 Project = (=TI - S A EMyFirstSQL.osql |
~v & MyfirstProject C\Users\AdministratoriIdeaProjects\M SEET v | | MaxComputeZSBIEsE | BRLAES
? idea 1 ——name MyFirst5QL
~ [ MyFristModule
- erc M Cut Cirl+y | P Kotlin File/Class
v main 5 Copy Cirl+c | E File
Copy Path Crl+Shifi+C | B Scratch File Ctrl +Alt+Shift +Insert
resources Copy Reference Ctrl +Alt+5Shift+C E
» test = Paste Ctrl+y | == FXML File
ackage-info.java
> target Find Usages AleF7 =P e g
aMyFristModuledn  Find in Path.. Ctrl+Shift+F
o]
11 pomuxml Replace in Path... Ctrl+Shift+R MaxCompute SQL EZ
] =
> scripts Analyze 3 & MaxCompute ZE 558
HTML File
target Refactor H o
v warehouse i JavaFXApplication
. Add to Favorites inal
v example_project h humbnail s Shift i Singleton
3 _resources_ ErE R s Crl+Shit+T | @ Gradle Kotlin DSL Build Script
v _tables__ Reformat Code Cirl+Alt+L | @ Gradle Kotlin DSL Settings
3 ads_log Optimize Imports Cirl+Alt+O | 22 XSLT Stylesheet
b kmeans_ir Delete... lze=z Edit File Templates...
5 kmeans_o Build Madule 'MyFristModule’ GUI Farm
» pagerank Rgbuild 'adefaults" Ctrl+5Shift+F9 D‘iEIDg
? pagerank, P Run All Tests e Form Snapshot
? rs_out #& Debug "All Tests 11 Resource Bundle
3 sssp_in ¥ Run 'All Tests' with Coverage Plugin Deviit 5
¥ sssp_out | (@] Create 'All Tests'...
> we_inl Show in Explorer
¥ we_in2 Open in terminal
> we_out | [ Set MaxCompute project
u MyfirstProject.iml Lresl 5
> ||l External Libraries (5 Synchronize Yjava’
» [ Scratches and Consoles .
Directory Path Ctrl +Alt+F12
4% Compare With... Ctrl+D
Open Module Settings F4
D MaxCompute Java is use Load/Unload Modules..
—— 3 Mark Directory as >
" @ & Create Gist...




2. Set Name and Kind, and click OK. as shown in the following figure.

I o

Create new MaxCompute java class @
Name:  MyFirstUDF !

Kind: | ure IJDF v|
B uoar

BE upTr —
&F Driver

@ Mapper

% Reducer

o StorageHandler

|\ Extractor

- Name: Specifies the name of the MaxCompute Java Class. If you have not created
a package, you can enter packagename.classname to automatically create a
package.

- Kind: Specifies the type. Supported types include custom functions (UDF/UDAF/
UDTF), MapReduce (Driver/Mapper/Reducer), and non-structural development (

StorageHandler/Extractor).

3. After the creation is successful, the Java program can be developed, modified, and
tested.

“* MyfirstProject ) ['; MyFristModule ) % src ) I main ) [ java ) (€ MyFirstUDF ) bt [¥h MyFirsts
[ Project ~ @ & | % 1= | BMyFirstSQLosql € MyFirstUDF java
v &% MyfirstProject C:\Users\Administrator\IdeaProjectsi\M Project SDK is not defined

> idea
v MyFristModule

> examples

import com. aliym, odps, udf. UDE;

public class HyFirtIDF extends UDF {

~ e // TODO define parameters and return type, e.g: public String evaluate (String s, String b)
v main publie String evaluate(String s) { return "hello world:” + s; }
v [java !

» (€ HelloDriver

v & MxFirslUDF |
m evaluate(String):String —

resources

E] Note:

Here's a code template that can be customized in Intellij. You can define it in

Preference > Editor > File > Code Templates. Then look for the corresponding

template in the Code tab.
For detailed development steps, seeJAVA UDF development.
Normally, the development of JAVA UDF can be done in the following ways:

- Use MaxCompute Studio to complete the whole process of JAVA UDF development.



- Use Develop and debug JAVA UDF using the Eclipse plug-in, export the Jar package, then

Add resources through commands or DataWorks, and Register the function.

For detailed development steps, seeJAVA UDF Development.

Debug the UDF program

After the UDF program is developed, it can be tested using unit test (UT) or local

running to check whether it meets expectations.

Unit Testing

There are various UT examples in the examples directory and you can refer to them to

compile your UT.

>
w

w

>

>

« MyfirstProject

G Project = L2 ]

MyFristModule ;7 examples

=
=

idea

MyFristModule

£ ¥ ¥ OV v v

WO W v

v main

examples

com.aliyun.odps.examples

com.aliyun.odps.examples.graph

com.aliyun.odps.examples.mr

com.aliyun.odps.examples.mr.test

com.aliyun.odps.examples.udf

com.aliyun.odps.examples.udf.test
> (€ UDAFTest

~ (€' UDFTest

i initWarehouse(J:void

it

it

il . simplelnput(:void
> (€ UDTFTest

inputFromTable(void

resourceTest()wvoid

com.aliyun.odps.examples.unstructured
com.aliyun.odps.examples.unstructured.test
data.ambulance_csv

data.speech_wav

src

v java
w € HelloDriver
m main(String[]):void
v (€ MyFirstUDF
m evaluate(String):String

resources

A test

java
target
= MyFristModule.iml

pom.xml

scripts

com

#- 1= | EJMyFirstSQLosql

edps ) B8 examples ) B8 udf )

€ MyFirstUDF.java

aliyun

€' UDFTest.java

|2

»

v N foirstProiect C:\Users\Administrator\ldeaProjects\M Project SDK is not defined

package com. aliyun. odps. examples. udf. test;

import ...

public class UDFTest {

@Beforellass

publiec static void initWarehouse() [ TestUtil. initWershouse(); }

@Test

[pablie void simpleInput () throws Excepti

BaseRumner rumer = new UFRumer ( 00ps

runner. feed(new Object[] { “one”, “one”|

.feed(new Object[] { “four” "four’l

List@bject[]> out = rumer. yield();

sizel)):

one, one”,

hssert assertEquals (3, out
Tes

three, three”

Assert. assertEquals ("ss2s:

Assert. assertEquals (“ssZs:

Assert, assertEquals ("ss2s: four, four”, ]

@Test

publiec void inputFromTable () throws Excey
BaseRunner runner = new UDFRunner (TestUti
String project = “example_project”;
String table = "we_in2";

String[] partitions = new String[] { “p2

Cut
= Copy
Copy as Plain Text

Copy Reference

= Paste

Paste from History...
Paste Simple

Column Selection Mode
Find Usages

Refactor

Folding

Analyze

Search with Google

Go To

Generate...

jor Recompile 'UDFTest.java’

Ctrl+X
Ctrl+C

Ctrl+Alt+Shift+C
Ctrl+V
Ctrl+Shift+V
Ctrl+Alt+Shift+V
Alt+Shift+Insert

Alt+F7

>
Alt+Insert

Ctrl+Shift+F9

String[] colunns = new String[] { “cole o il AT
P 0" trl+ +
InputSource inputSource = mew_TableInputAUA LY Rl

Object[] data;

#i Debug 'simplelnput()’

while ((data = inputSource. getllaxtRow ())| %% Run ‘'simplelnput() with Coverage

runner. feedidatal;
I
ListObject[]> out = runner. yield();
Assert assertEquals i3,
UDFTest

out. size()):

simplelnput()

Run locally

[ IDE and Plugin Updates: Intelli) IDEA is ready to update. (today 16:45)

[#¥] Create 'simplelnput()"...
Show in Explorer
Open in terminal
Local History

[§+ Compare with Clipboard

During local running of the UDF program, the running data source must be specified.

The following two methods are provided to set the test data source:



MaxCompute Studio uses the Tunnel Service to automatically download table data
of a specific project to the warehouse directory.
The mock project and table data are provided. You can see example_project in

warehouse to set it by yourself.
Procedure

1. Right-click UDF Class and select Run UDF class.main(). The Run Configuration
dialog box is displayed. In normal cases, UDF/UDAF/UDTF data is used as columns
in tables of a select sub-statement. The MaxCompute project, table, and column
need to be configured. (The metadata is from the mock project under project
explorer and warehouse.) Debugging for complex types is also supported, as shown

in the following figure:

Project Explorer - 1= | BJMyFirstsQL.osgl € MyFirstUDF,java €' UDTFTestjava
+ - 0 ES % | =
~ 34 hitpi//service.odps.aliyun.com/api

v {B] MySecondProject2
v [g Tables & Views

| Project SDK is not defined

import org junit. BeforeClass;

import org junit Test;

> [ bank data
3 emp_test_new import java util List
> Fl ods user info.d [(ahesnive (" array<struct<x:bigint y:bigint>> ~>bigint”))|
> [ result_tabl public class UDIFTest UDTF{
> [ result_table
> [Eltable1 Run/Debug Configurations @
> [ table_2
> Eltable_3 + — E ¥ > Name: UDTFTest [[]1Share []Single instance only
> Eltable_a > [Junit
> Eltable s Main class: com.aliyun.odps.examples.udfitest UDTFTest
v [ table 6 ~ ‘AMaxCompute Java

|ifllcol1 :ARRAY <struct<x: " UDTFTest VM options:

col2 :BIGINT ' > i MaxCompute SQL

col3 :BIGINT Program arguments:
> 5 Default

B cold BIGINT ¥ Defaults
v [ table_7 Working directory: ~

f coll :BIGINT . .

B col2 :ARRAV<BIGINT> Environment variables:
> Eltables
> Ewcinl Use classpath of madule: MyFristModule ~
> El winc

3 [JJ Functions [1Include dependencies with "Provided” scope
> [ Resources IRE: Default (<no JRE> - module not specified) v
Shorten command line: user-local default: none ~
Enable capturing form snapshots (requires JRE 5.0 or higher]

*MaxCompute project: http://service.odps.aliyun.com/api >  MySecondProject2 ~ +
*MaxCompute table: | we_inl v

*Table columns: coll iescl,c2!

Download Record limit: | 100




2. Click OK.

[ Project -
[ out '
[ scripts
[ target
[ warehouse
meta_dev
__tables__
hy_test
=| __schema__

2]
KA
-3

- I+ ahy_test % Estudiotestl.osql *® € PlusHello java * o UDFTest. java X

package myudf;
import com.aliyun.odps.udf.UDF;

public class PlusHello extends UDF {
'/ TODO define parameters and return type, e.g: public &
public String evaluate(String s) {
return "hello world:" + s;
H
public String evaluate{Long a, String b) {

return “hello world2:" + a + " " + b;

mstudioTest.iml
il External Libraries

Run PlusHello
P8 LBE T ¢+ »

=] Test framework guit unexpectedly

[% Note:

}

/Library/Java/JavaVirtualMachines/jdkl.8.0_65.jdk/Contents/Home/bin/java ...

Testing started at 15:02 ...

[INFO]Start to write table scheme : meta_dev.hy_test——=/Users/1liuyi/IdeaProjects,
[INFO]generate schema file: /Users/liuyi/IdeaProjects/studioTest/warehouse/meta,
[INFO]Finished to write table scheme : meta_dev.hy_test——=/Users/liuyi/IdeaProj¢
[INFO]Start to download table: 'meta_dew.hy_test', download mode:AUTO
[INFO]Tunnel DownloadSession ID is : 2@8160930150300d492b70a@1854c05

[INFO]Start to write table: meta_dev.hy_test——>/Users/liuyi/IdeaProjects/studio”
[INFO]Finished write table: meta_dev.hy_test-->/Users/liuyi/IdeaProjects/studio
hello world2:1 a

hello world2:2 b

hello world2:3 c,d

Process finished with exit code @

- If the table data under the specified project is not downloaded into glashourse

, You need to download the data first, default download 100 entries. If more

data is required, use the Tunnel Command of the console or table downloading

function of Studio.

- If the mock project is used or the table data is downloaded, directly run the

program.

- The UDF local run framework uses data in specific columns in warehouse as the

UDF input and run the UDF program locally. You can view log output and result

display on the console.

Local warehouse directory

The local warehouse directory is used to store tables (including meta and data) or

resources for local UDF or MR running. The following figure shows the warehouse

directory.



5 Project v @ = | ¥~ I E __schema__

sandbox ~/ldeaProjects/sandbox project=example_project
.idea table=wc_inl
jDev columns=coll:STRING, col2:STRING, col3:STRING, col4:STRING
out
scripts
target
warehouse

example_project
__resources__
__tables
rs_out
wc_inl
= __schema__
= data

pl=2
= __schema__
wc_out

Note:

- The project name, tables, table name, table scheme, and sample data are under
the warehouse directory in sequence.

- The schema file is configured with the project name, table name, and column
name and type (separated using a colon) in sequence. For a partition table, the
partition column also needs to be configured. (For a non-partition table, refer to
wc_inl. For a partition table, refer to wc_in2).

- The data file uses the standard CSV format to store table sample data.

Special characters include comma, double quotation marks, and line feed (\n or

\r\n).

- The column separator is comma and the line separator is \n or \r\n.

- If the column content includes special characters, double quotation marks ( )
must be added before and after the column content. For example, if the column
content is 3,No, it is changed to “3, No” .

- If the column content includes double quotation marks, each double quotation
mark is converted to two double quotation marks. For example, if the column
contentisa” b” c,itis changedto “a” ” b” ” ¢”

- \N indicates that a column is null. If the column content (string type) is \N, it

must be convertedto “” 7 \N” 7 7,

- The file character code is UTF-8.



2.6.3 Develop MapReduce

After the Create MaxCompute Java Module is created, MR can be developed.

Develop the MR program

1.

Right-click the module source code directory src > main, select New > java, and

select MaxCompute Java.

. Create Driver, Mapper, and Reducer.

=

Create new MaxCompute java class |E|
Mame: Tl
Kind: & Driver b

OK Cancel

3. Set the input/output table and Mapper/Reducer class. The framework code is

automatically filled in the template.

¢’ HelloDriver java

HelloDriver

package mymr.myudf;

import ...

public class HelloDriver {

public static void main(String[] args) throws OdpsException {

JobConf job = new JobConf();

// TODO: specify map output types
job.setMapOutputKeySchema(SchemaUtils. fromString( ?));
job.setMapOutputValueSchema(SchemaUtils. fromString(_?));

// TODO: specify input and output tables
InputUtils.addTable(TableInfo.builder().tableName(_7?).build(), job);
OutputUtils.addTable(TableInfo.builder().tableName(_?).build(), job);

// TODO: specify a mapper
job.setMapperClass(_?);

// TODO: specify a reducer
job.setReducerClass(_?);

RunningJob rj = JobClient.runJob(job);
rj.waitForCompletion();

For details of developing MR, see To write MapReduce.



Debug the MR program

After the MR program is developed, test your code and check whether it meets the

expectations. The following two methods are supported:

Unit test (UT): There are WordCount UT examples in the examples directory. You can

refer to them to compile your UT.

07 Project = € = | #- |- | © HelloDriver.java € WordCountjava € WordCountTestjava
v o MyfirstProject C\Users\Administrator\ldeaProjects\M Project SDK is not defined
’ ddea package al. dp 1 test
. com. aliyun odps. exanples. mr. test;
v [ MyFristMedule
v examples import .
w com.aliyun.odps.examples
> (B TestUtil ¥ 5 - ~ -
85- 1 lh'.l.l. ellu Icr&.\m#.'le:l extends N Cut Curl+X
> com.aliyun.odps.examples.graph A EN) sches i Copy Ctrl+C
> com.aliyun.odps.examples,mr 2 private final statie Strang INPUT

v Pa comaliyun.odps.examplesirtest private final statie String ourpys oY as Plain Text

R private TobConf job: Copy Reference Ctrl +Al+Shift+C
i r lesudf - B Paste Ctel +V
> com.aliyun.odps.examples.u - -
" e 1_w dp = .PI - Af public WordCountTest() threws Exceps  Paste from History. Crl+5hift+V/
m""-ﬂ;'."‘-'”'“dps'mmpl“'” i » Testltil im tHarehouse (); Paste Simple Ctrl+Alt+Shift +V
> . Y . ! P - . ;
oot :W" S PR LR AR EwmEdlmE Column Selection Mode Alt+Shift+Insert
> com.aliyun.odps.examples.unstructured tesT ok = new JeblomE(): .
> data.ambulance_csv —_ Find Lisages L
Ref: »
> data.speech_wav Job. setMappertlass (Wer dCount. Tolent Befactor
» sre Job_ setCombinerlass Wordlount SunC|  Folding ¥
» target — Job setReducerClass Wor dCsunt SunRe Analyze >
 MyFristMeduleiml Search with Google
- Job. zetlaplutpatKeySchena (5 chemallty]
pom.xmml Go To 3
. job. setMagutput¥alues chema (Schemall
. SCripts Generate... Alt+Inzernt
¥ i : - - :
'dE‘_! Inputltils, addlable (TubleInfe. builds  Recompile "WordCountTestjava' Ctrl+Shift+F9
EJMyfirstsQLosql OutputVeils. addlable TableInfo. buil JETTRTI o rns Ctrl+Shift+F10
target 1

W Debug "WordCountTest'

v warehouse F% Run 'WordCountTest' with Coyerage

v example_project FSuppressiarnings {"deprecation”) _
3Test 4| Save ‘WordCountTest'
> _resources__ fles X
v B _tables_ L4 public veid testap () throws I0Exce  SNOW II"ENDIcI’rer
- ads Jog NaplTContext mapCentext = new MaplTi B Open in terminal
2 ochems maplontext, setInputs chema (TFPUT_SC, Local History b
N - napContext, setlutputSchema (OVTPUT_ 2 .. . )
d data TR [+ Compare with Clipboard
? kmeans_in Becord record = maplontext. createlng File Encoding
) kmeans_out record set {new Text[] {new Text( st (5 Create Gist..

Local MR running: During local running, the running data source must be specified.

The following two methods are provided to set the test data source:

MaxCompute Studio uses the Tunnel Service to automatically download table data
of a specific MaxCompute project to the warehouse directory. By default, 100
data records are downloaded. If more data is required for testing, use the Tunnel
Command of the console or table downloading function of MaxCompute Studio.
Provide the mock project (example_project) and table data. You can see

example_project in warehouse to set it by yourself.



1. Run the MR program. Right-click the Driver class and select Run. In the displayed
Run Configuration dialog box, configure the MaxCompute project on which the MR

program runs.

.

Run/Debug Configurations &=

+ — B EH % 1+ MName: WordCountTest [ Share []Single instance only
v JUnit 5
= " Configuration | Code Coverage | Logs
UDTFTest
AUDFTe Test kind: Class A Fork mode: | none ~ | Repeat: | Once w [ (1
M| |NTE
e Class: com.aliyun.odps.examples.mrtest WordCountTest
WordCountTest
> MaxCompute Java
> MaxCompute SQL
pute SQ VM options: -ea

> PSDefaults

P rogram arguments:

Working directory:

Environment variables:

%MODULE_WORKING_DIR%

Use classpath of madule: MyFristModule ~

JRE: Default (=no - module not specified)

Shorten command line: user-local default: none ~
+ Before launch: Build, Activate tool window

+

Vi Build

[] Show this page [] Activate tool window
@ Warning: No JDK specified for medule ‘MyFristModule'

Cancel Apply

2. Click OK. If table data of the specified MaxCompute project is not downloaded

to warehouse, download data first. If a mock project is used or the MaxCompute

project table data is downloaded, skip this step. Then, the MR local run framework

reads specified table data in warehouse as the MR input and runs the MR program

locally. You can view log output and result display on the console.

Run '\ WordCount

» /Library/Java/JavaVirtualMachines/jdk1.8.0_65.jdk/Contents/Home/bin/java ...
[INFO]Run mapreduce job in local mode, Type: MR, Job ID: mr_20170221193325_750_3935

[INFO]Start to
[INFO]Start to
[INFO]Finished
[INFO]Start to
[INFO]Finished
[INFO]Finished
[INFO]Start to
[INFO]Start to
[INFOlgenerate
[INFO]Finished
[INFO]Finished
[INFO]Start to
[INFO]Finished
[INFO]Start to
[INFO]Finished
[INFO]Start to
[INFO]Finished
[INFO]Start to
[INFO]Start to
[INFO]Start to

18

1
X %

-~

process input tables

copy table: example_project.wc_inl-—>/Users/liuyi/IdeaProjects/sandbox/temp/mr_20170221193325_750_3935/input/example_project/wc_inl

copy table: example_project.wc_inl-—>/Users/liuyi/IdeaProjects/sandbox/temp/mr_20170221193325_750_3935/input/example_project/wc_inl

copy table: example_project.wc_in2{pl=2, p2=1}-->/Users/liuyi/IdeaProjects/sandbox/temp/mr_20170221193325_750_3935/input/example_project/wc_in2
copy table: example_project.wc_in2{pl=2, p2=1}-->/Users/liuyi/IdeaProjects/sandbox/temp/mr_20170221193325_750_3935/input/example_project/wc_in2
process input tables

process output tables

write table scheme : example_project.wc_out-->/Users/liuyi/IdeaProjects/sandbox/temp/mr_20170221193325_750_3935/output/__default__

schema file: /Users/liuyi/IdeaProjects/sandbox/temp/mr_20170221193325_750_3935/output/__default__/__schema__

to write table scheme : example_project.wc_out-—>/Users/liuyi/IdeaProjects/sandbox/temp/mr_20170221193325_750_3935/output/__default__

process output tables

process resources

process resources

fill tableInfo

fill tableInfo

validate configuration

validate configuration

run mappers, num: 2

run mapper, TaskId: M_000001, Input: example_project.wc_inl

run Combiner, TaskId: M_000001

[INFO]Fininshed run Combiner, TaskId: M_000001
[INFO]Fininshed run mapper, TaskId: M_000001, Input: example_project.wc_inl




Run the MR program in the production environment

After local debugging is complete, release the MR program to the server and run it in

the MaxCompute distributed environment.

1. Package the MR program to a JAR package and release it to the server. For more
information, see Package, Upload, and Register.

2. Use the MaxCompute console integrated with MaxCompute Studio in seamless
mode, that is, in the Project Explorer window, right-click Project and select Open
in Console, and input the commands similar to the following JAR command in the

console command line:

jar - libjars wordcount . jar - classpath D :\ odps \ clt \
wordcount . jar com . aliyun . odps . examples . mr . WordCount
wc_in wc_out ;

2.6.4 Unstructured development
An unstructured data processing framework is added for MaxCompute 2.0, supporting
access to the OSS and Table Store using external tables. Studio provides some code

templates for the framework, facilitating users' fast development.
Compile StorageHandler/Extractor/Outputter

1. After the MaxCompute Java Module (Sample code is provided in the unstructured
folder of the examples directory for your reference).

2. Right-click the module source code directory src > > main, select new, and select
MaxCompute Java.

3. Specify Name and Kind. For example, set Name to myun.MyExtractor and Kind to
Extractor. Click OK.

Create new MaxCompute java class EZ |
Mame:  myun.Extractor !
Kind: Extractor ~

OK Cancel

4. The framework code has been automatically filled in the template. Compile your

logic code.

5. Compile Outputter and StorageHandler by following the preceding steps.



Unit Testing

You can compile the unit test (UT) by following the examples in the examples

directory to test your Extractor/Outputter.

Project - @ = | #- |- (& ExtractorTestjava
L stuqioTest ~fldeaProjects/studioTest ExtractorTest || ambulanceFullSchema
:ldea 3 import ...
jdev 18
examples 19 G plilic class ExtractorTest {
com.aliyun.odps.examples 20 private StrilMIEITTEITFullSchena =
21 "vehicle:bigint;id:bigint;patient:bigint;calls:bigint;latitude:dc
m(;f 22 private String speechDataFullSchema = "sentence_snr:double;id:string'
u e
unstructured 24 @Test
test 25 G public void testTextExtractor() throws Exception {
26 /%%
ExtractorTest 27 x Equivalent to the following SQL:
¢’ % OutputerTest 28 CREATE EXTERNAL TABLE ambulance_data_external
¢ SpeechSentenceSnrExtractor.jave 29 ( vehicle bigint, id bigint, patient bigint, calls bigint,
30 Latitude double, Longitude double, time string, direction string)
< Sheechetorageliand ey 31 STORED BY 'com.aliyun.odps.udf.example.text.TextStorageHandler"'
¢ = TextExtractor 32 LOCATION 'oss://.../data/ambulance_csv/'
E TextOutputer 33 USING 'jar_file_name.jar';
¢ % TextStorageHandler 34
. 35 SELECT * FROM ambulance_data_external;
¢ = TestUtil 36 */
data 37 Column[] externalTableSchema = UnstructuredUtils.parseSchemaString!

Package and upload

After StorageHandler/Extractor/Outputter is compiled, compress the completed Java
program to a JAR package, and upload the package as a resource to the server, see

Package and release.



Create External Table

1. Right-click scripts and select new > MaxCompute Script.

v arget o
L MyFrist Cut Cirl+x | K Kotlin File/Class
2 pom.xr |5 Copy cul+c | = File
—g_ - scripts Copy Path Cirl+Shifi+C | B2 Scratch File Ctrl+Alt+5Shift+Insert
_'E b Jidea Copy Reference Ctrl+Alt+Shift+C Package
i EJMyFirst) (2 Paste Ctrl+y | FXML F”El .
target Find Usages Altrr7 | packagel-lnfcj.]ava
> warehouse Find in Path.. Ctrl+ShiftaF |3 module-info java
aMyfirstPral  Replace in Path... Ctrl+Shift+R
> |l External Libral  Analyze 5 B MaxCompute BT
» [ Scratches and Refactor y E M D2 hnEE
B iy HTML File
G T TS ’ i JavaFXApplication
Show Image Thumbnails Cirl+Shift+T g Singleton
Reformat Code Cirl+Alt+L |8 Gradle Kotlin DSL Build Script
Optimize Imports Ctrl+Alt+O |8 Gradle Kotlin DSL Settings
Delete... Delete | . XSLT Stylesheet
Build Module "MyfirstProject’ Edit File Templates...
% Rebuild '=default=" Ctrl+Shift+F2 GUI Eorm
= Show in Explarer Dialog
E‘, [E Open in terminal Form Snapshot
5. B Set MaxCompute project ! Resource Bundle
n Local History > Plugin DevKit >

2. Enter the SQL script name. Select the MaxCompute project in which the script is to
be executed for Target Project and click OK.
3. Select create external table live template in the editor to rapidly insert the script

template for creating an external table.

Modify the external table name, column, type, StorageHanlder class path,
configuration parameter, external path, and JAR name. Click Run MaxCompute
SQL Script to create the external table.

4. Query the created external table.

2.6.5 Develop Graph

After the MaxCompute Java module is created, Overview of Graph models can be developed.

Sample Code

There are some code examples of Graph in the examples directory, and you can refer

to the example to get familiar with the structure of the Graph program.



Project v @ = | - |- (@ PageRankjava
W\ sandbox ~/ldeaProjects/sandbox
idea import ...
graph Sk
examples % Set program arguments:
com.aliyun.odps.examples A pagerank_in pagerank_out
graph *
» */
s > public class PageRank {
¢’ PageRank
¢ SSSP public static class PageRankVertex extends
mr Vertex<Text, DoubleWritable, NullWritable, DoubleWritable> {
udf @Override
unstructured ) public void compute(ComputeContext<Text, DoubleWritable, Nullwr
¢ TestUtil Iterable<DoubleWritable> messages) throws IOException {

data if (context.getSuperstep() == @) {
setValue(new DoubleWritable( value: 1.8 / context.getTotalNun

sre } else if (context.getSuperstep() >= 1) {

target double sum = 0;
= graph.iml for (DoubleWritable msg : messages) {
sum += msg.get();
pom.xml N

Develop a Graph Program

1. Right-click the module source code directory src > > main, select new, and select
MaxCompute Java.

2. Select the GraphLoader/Vertex type and enter the class name (package name
is supported) in the Name text box. Click OK, and the frame code will be

automatically filled in by the template, you can continue to modify.

(=)

Mame: Tl

Create new MaxCompute java class

Kind: | uer UDF v
) StorageHandler
I\ Extractor
r— () Outputer —
un und
W\ Vertex

»
W\ VertexResolver

W\ Combiner

Debug Graph Locally

After the Graph program is developed, test your code and check whether it meets the

expectations. You can run the Graph code locally.



1. Run the Graph program: Right-click the Driver class and select Run. In the

displayed Run Configuration dialog box, configure the MaxCompute project on

which the Graph program runs.

u
£ impart
S
L 3 public elass HelleDriver |
]
i) > public static veid suin(String(] args) throws Odp
¥ JabConf joh = new TobCenf():
i
&
TODO: specify map sutput types

Jab. setMaplutyuteySchena Schemalitils fremString]
2 jab. setMaplutputValusSchens (Schemalltils. froaStrin
-
&
E T0D0: specify input and cutpst tables gf
g Ingutlftils. addable TableInfo. builder (). takLellane]

Outputlitils. addlable Tablelnfe. buslder (). tablalim)

TORO: specify a mapper
Job. sutMupparilass( 7}
TOBO: specify a reducar

Jab setReducerClass( 7)
BusmingTeb £j = JebClient. runfeb(job);
v waitForConpletion():

HelloDriver  main{)

Messages:  Build

W= @ Information: java: Errors occurred while compiling m
® . O Information: javac 18.0_ 181 was used to compile javy
g T | @ Information: 2018/12/13 16:15 - Compilation complet
g% & v Zcw inistrator\ideaProjects\MyfirstProje
= 4 © Ervon(l?, 59) jove: SEEEIATITTE

:‘ O Erron(l7, 60) jova: EMMETTE
| © Errori(17, 61) jova: SEESIRESTE
§ k] © Erron(17,62) java: REY
H © Errori(17,63) java: BB
= © Error(18, 61) jova: SEEMESI TG

B Run/Debug Configurations

+ - H ¥t

> [l dunit

~ WAMax€empute Java
WL LUDTFTest

===}

Mame:  PageRank [JShare [] Single instance only

Main class: com.aliyun.odps.examples.graph.PageRank

VM options:

Program apguments: PageRank_in FageBank_cat

Working directory:

Environment variables:

Use classpath of module: s MyFristModule w
[ include dependencies with "Provided” scope

IRE: Default (1 { ‘MyFristModule’ module] «|[
Shorten command fine: | user-local default: none v

[[] Enable capturing form snapshots

*MaxCompute project: local || example_project ||+

Download Record limit: | 100

~ Before launch: Build, Activate tool window
+

4 Build

[] Show this page [7] Activate tocl window

Cancel Apply

2. Click OK. If table data of the specified MaxCompute project is not downloaded

to warehouse, download data first. If a mock project is used or the MaxCompute

project table data is downloaded, skip this step. Then, the graph local run

framework reads specified table data in warehouse as the Graph input and runs the

Graph program locally. You can view log output and result display on the console.



Each time you debug locally , a new temporary directory is created under the

Intellij directory, as shown in the following figure:

[ Project - @ =  #»- I~ (@ PageRankjava
» » , T Tee e e e g S e T T T
V.S sanf:ldbox IdeaProjects/sandbox vertex.addEdge(new Text(edge.toString()), NullWritable.get());
.idea
graph
out System.out.println(“vertex edgs size: " + (vertex.hasEdges() ? vertex.getEdges().size() : 0));
) context.addVertexRequest(vertex);
scripts
target
temp ¥
A\ raph_201 22144 4_147!
B graph_201803 03‘63 o AAP private static void printUsage() {
counters <— ff —EHAIER System.out.println("Usage: <in> <out> [Max iterations (default 30)]");

input €—— {EL A4
outpute—— {ELAYER
resource €—— {E{EFAL

System.exit( status: -1);

@ pubuc static void main(String[] args) throws IOException {
superSteps <—— SR AE S if (args.length < 2)
e job.xml €— {ElER# printUsage();
warehouse .
= sandbox.iml Graphob job = (TYNGETINEIN:
\lli External Libraries job.setGraphLoaderClass (PageRankVertexReader. class) ;

ioh.setVertexClass(PaaeRankVertex.class) :
PageRank main()

Run PageRank
{: Start to write table scheme : example_project.pagerank_out-->/Users/l1uyi/IdeaProjects/sandbox/temp/graph_20180322144993_634_14/6/output/__detault__

| _EJ 22, 2018 2:49:03 T4 com.aliyun.odps.local.common.utils.SchemaUtils generateSchemaFile
3 : generate schema file: /Users/liuyi/IdeaProjects/sandbox/temp/graph_20180322144903_634_1476/output/__default__/_ schema__
_ 2, 2018 2:49:03 T4 com.aliyun.odps.local.common.utils.SchemaUtils generateSchemaFile
=3 Finished to write table scheme : example_project.pagerank_out-->/Users/liuyi/IdeaProjects/sandbox/temp/graph_20180322144903_634_1476/output/__default__
= 7}5] 22, 2018 2:49:03 T4 com.aliyun.odps.graph.local.master.Master init
= {881 worker num :1
= 1
= 2
o 4

|

vertex edgs size: 2
2

N
%

1
3
vertex edgs size: 2
4

X

2
3

E] Note:

For a detailed introduction to warehouse, see Local Warehouse Directory section

in Develop UDF.

Run the Graph Program in the Production Environment

After local debugging is complete, release the Graph program to the server and run it

in the MaxCompute distributed environment.

1. Package the Graph program to a JAR package and release it to the server. For more
imformation, please see How to package and release Graph.

2. Use the MaxCompute console integrated with MaxCompute Studio in seamless
mode, that is, in the Project Explorer Window, right-click Project and select Open

in Console, and input the commands similar to the following JAR command in the

console command line:

jar - libjars XXX . jar - classpath / Users / home / xxx . jar
com . aliyun . odps . graph . examples . PageRank pagerank_i n
pagerank_o ut ;

For more imformation about Graph development, please see Graph.



2.6.6 Package. Upload and Register

After a user-defined function or MapReduce is developed, you must package and release it

to the MaxCompute system.
Package a UDF or MapReduce

To release a UDF or MapReduce to the MaxCompute server for production use, you
must complete packaging > uploading > registration in sequence. You can use the
one-click release function to complete these procedures. MaxCompute Studio runs
the mvn clean package command, uploads a JAR package, and registers the UDF in
one stop. To use this function, right-click the UDF or MapReduce and select Deploy to
server---. Make sure that the target class is in the src > main > java subdirectory and is
successfully compiled on the Maven module. The dialog box shown in the following
figure appears. Select the MaxCompute project to be deployed and enter a resource
name and a function name. Click OK and wait until the operation in the background is

complete.

Package a jar and submit resource £2

*MaxCompute project: MySecondProject2 (service.odps.aliyun.com) o
*Resource name: MyFristModule-1.0-5NAPSHOT jar
*Main class:

*Function name:

Force update if already exists

ﬂ oK Cancel

Note:
If you require special packaging, you can modify relevant settings in the pom.xml
file. After packaging, follow these steps to upload the JAR package and register the
UDF.

Upload the JAR package
After the JAR package is prepared, upload it to the MaxCompute server.

1. Select Add Resource from the MaxCompute menu.



2. Select the MaxCompute project you want to upload the resource to, the JAR file
path, and the resource name you want to register. Determine whether to force

update when the resource or function already exists. Then click OK.

Add Resource 23

*MaxCompute project: MySesmea®rampeat2 (service.odps.aliyun.com) +
*Resource file: /MyfirstProject/MyFristModule/src/mainfjava/MyFirstUDF java

*Resource name: MyFirstUDF.java

Force update if already exists

0 oK Cancel

3. After uploading is successful, you can view the resource under the Resources node

of the Project Explorer window.

Project Explorer - A0

+ - O ERY ¥ = »
w YU httpy//service.odps.aliyun.com/api
v P] MySecondProject2
> [ Tables & Views
» [H Functions
v [ Resources

i- mElnwer.'iar

Register the UDF

@ L Project

“. Project Explaorer

After the JAR package is uploaded, register the UDF.

1. Select Create Function from the MaxCompute menu.



2. Select the required resource JAR and JAR main class, and enter the function name.

Click OK.
Create Function
*MaxCompute project: MySecondProject2 (service.odps.aliyun.com) R

*Function name:

MyModule-1.0-SNAPSHOT jar

*Using resources:

*Main class: MyFirstUDF ~
Force update if already exists

function name can't be empty

(7] Cancel

3. After the registration is successful, you can view the function under the Functions

node of the Project Explorer window.

FE Tables & Views
(] Functions

fx plushello

fx 5525
71 Resources

Apply the UDF

Apply the UDF in SQL to complete subsequent development.

meta_dev

Surround with ()
plushello(STRING) (UDF Function) STRING
PARSE_URL(STRING,STRING) S TRIP
PERCENT_RANK()

PI() )

PMOD (DECIMAL ,DECIMAL)
POSITIVE(T)
POW(DOUBLE , DOUBLE)
POWER (DECIMAL,DECIMAL)
PRINTF(STRING,ANY)

MAY DT/ICTDTMMY ] + € n n . . TD TR
Press ~.to choose the selected (or first) suggestion and insert a dot afterwards 2> 11




2.7 Manage MaxCompute jobs

2.7.1 Job viewing
MaxCompute Studio supports viewing information of MaxCompute running instances
submitted by the current user, including the running status, job type, and start and

stop time.
Open Job Explorer

If Job Explorer View is not displayed on Dock on the left, open Job Explorer by

choosing View > >Tool > Windows > > MaxCompute Job Explorer.

MyfirstProject [C\Users\Administrator\ldeaProjects\MyfirstProject] - ..\scripts\HelloTe:
File Edit | WETE Navigate Code Analyze Refactor Build Run Tools VCS Windo
Tool Windows ¥ 'm Project Alt+1
o] g Quick Definition Ctrl+Shift+1 | W Favorites Alt+2
2 Ehew Siblngs P Run Alt+4
a v W : - Debu Alt+5
= R Quick Documentation Ctrl+Q g -
= )
] X Parameter Info Ctrl+p | 2 TODO Ale+6
Expression Type Cirl+Shift+p | 4 Structure Alt+7
[ LY T == ~ Aly o
g Context Info Alt+Q Version Control Alt+9
E— , & Ant Build
& Recent Files Ctrl+E : S
apture Analysis
_Ei Recently Changed Files Ctrl+Shift+E . '
= , Capture Tool
o Recent Changes Alt+Shift+C
A Console
+* Compare With... Ctrl+D Desi
esigner
| = '_ 0 =
g I:‘- LETEIln Lperane Educational.CheckDetails
E. Quick Switch Scheme... Ctrl+” | Event Log
= ? Toolbar Wi FAQ Robot
WA + Tool Buttons Image Layers
> g, Status Bar Job Explorer
> Ee . ;
v Mawvigation Bar M Maven Projects
Active Editor Palette
Bidi Text Direction Palette
. Project Expl
Enter Presentation Mode T [z IXP orer I
. . @ T i Alt+F12
Enter Distraction Free Mode AT
Theme Preview
Enter Full Screen
UI Designer

View all job instances in a project

Job Explorer allows you to query submitted job lists by status.



Click the date drop-down box to select another date.

Click Refresh to obtain the job list.

Note:
By default, only the first 1,000 jobs that meet the conditions are displayed. If more

than 1,000 jobs meet the conditions, update the filtering conditions.
Sort the job list

You can click the column name in the job list to sort the jobs.

Job queue

If a job in running status is waiting for scheduling in a queue, the job’ slocation in

the queue and global priority is displayed in the job list.

Note:
The job status and queue location on the Running Instances tab are automatically

updated. After a job finishes, it is removed from the list.
Save job logs

Currently, Logview logs of a job are saved for seven days by default. If you want to
save some important Logview logs for a longer period and view them in the future,

you can save them locally.
Double-click a job in the list to display the job details on the right. Click Save on the

toolbar to save the logs to your local host.

You can set the path for saving the log file on the Setting tab of MaxCompute Studio.

2.7.2 Job instance

View a job instance
Studio supports the following two ways to view MaxCompute job instances:

1. Open the details of a job in read-only mode using a Logview URL or local offline

Logview file.

Users of MaxCompute will be familiar with using Logview to view the details of

a job. Using Logview, you can also view the status of tasks submitted by other



users in other projects. You can also view the details of any job by entering a valid

Logview URL in Studio.

In the menu bar, select MaxCompute > Open Logview. Valid Logview URLs in the
Clipboard are automatically copied to the dialog box displayed. Alternatively, you

can select to export the local offline Logview file.
2. In Job Explorer, double-click a MaxCompute instance to view its details. You can also

right-click the instance and select Open.
Job details view

The job details view page comprises a toolbar at the top, a properties bar on the left,

and a detailed view on the right. The detailed view consists of seven views:

- Execution view: Displays the overall information of a job in the form of a DAG. You

can view the dependencies and detailed execution plans for each subtask.

- Timeline view: Displays the execution timeline of a job, allows you to view this

timeline in different granularities, and provides a number of filters.

- Details: Displays the details of a job in table view, including the subtask list,
the worker list for each subtask, the volume of data processed by workers, the

execution time, and the status.

- Script: Displays the corresponding SQL statement and parameter configuration for

when a job is submitted.
- Summary (JSON): Displays the running details of a job in JSON format.
- Result: Displays the running results of a job.

- Analysis: Provides scatter plots, long tail distributions, and skewed data charts to

show the results of a job execution.



@Job 1D: 20170208232404727gchxi7ul *

.-SQL.0.0.0_job_0| ..u1 SQL_0_0_merge |

Task Name: meta_dev_20170208232404727gchxi7ul_SQL_0_0_0_job_0

Task | I/ORecords | Status I Progress I StartTime I EndTime. |
10766488/863168 TERMINATED 100.0 2017-02-09 07:24:19  2017-02-09 07:26:15

189073612537 RMINATED 100.0 2017-02-09 07:24:19 | 2017-02-09 07:
...SQL.0.0_0_job_0 865705/967 TERMINATED 100.0 2017-02-09 07:26:16 _ 2017-02-09 07:
R4 1967/967 2017-02-09 07: 2017-02-09 07:26:46
M1 M2
Instance count: o/s2/sz Instance count:o/3/3

/0 Records:10766488/863161 | 1/0 Records:13907361/253)

2017-02-09 07:24:19 2017-02-09 07:24:19
2017-02-09 07:26:15 2017-02-09 07:24:43

3

Instance count: 0/85/35
1/0 Records:365705/967

2017-02-09 07:26:16
2017-02-09 07:26:38
100%

= M1 x| M2 % [1312% Ra3 |
Instance Count: 6/85/8¢ Instance | /ORecords | [FinishedPercent... _ StartTime | EndTime
1/0 Records:967/967 R4_3#0 0 0/0 100.0 2017-02-09 07.... 2017-02-09 07
e R4_3#10_0 0/0 100.0 2017-02-09 07.... 2017-02-09 07
oiroaos oniaeiae R43#110 0/0 100.0 2017-02-09 07... 2017-02-09 07
o e R4_3#12.0 0/0 100.0 2017-02-09 07.... 2017-02-09 07
R43#13.0 0/0 100.0 2017-02-09 07.... 2017-02-09 07
R43#14°0 0/0 100.0 2017-02-09 07... 2017-02-09 07
R43#15.0 0/0 100.0 2017-02-09 07.... 2017-02-09 07
R4_3#16.0 0/0 100.0 2017-02-09 07.... 2017-02-09 07
R43#17.0 0/0 100.0 2017-02-09 07.... 2017-02-09 07
R4_3#18.0 0/0 100.0 2017-02-09 07.... 2017-02-09 07
R4_3#190 0/0 100.0 2017-02-09 07.... 2017-02-09 07
RA3#1 0 0/0 100.0 2017-02-09 07.... 2017-02-09 07
R4_3#20_0 0/0 100.0 2017-02-09 07.... 2017-02-09 07
R4_3#210 0/0 100.0 2017-02-09 07.... 2017-02-09 07
R4_3#220 0/0 100.0 2017-02-09 07.... 2017-02-09 07
[2017-02-09 07:24:05 07:27:28 2017-02-09 07:27:28 | R4 3#23 0 0/ 100.0 2017-02-09 07. 2017-02-
|| st [ = pson)| = )| @R | saL|
“26TODO @ ANTLR Preview @ Tool Output | VA RunningInfo | [ Terminal “/\ Running Result I Q) EventLog

Toolbar

Collapse pages on left/right

<
>

Used to expand or collapse views on the left and right, allowing you to focus on a

particular view.

Stop a job



MaxCompute Tools and Downloads / 2 MaxCompute Studio

Used to stop a job that is being executed. You need permission (owner or

administrator) to do so.

Refresh details

The basic information of a running job, such as its status and quota, is refreshed
automatically, but the detailed view on the right is not. If you want the most up-to-

date details, you have to refresh them manually.
Copy Logview
Copies the corresponding Logview of a job to the Clipboard.

Open job details in a browser

£3

Generates a Logview URL and opens it in a browser.

Store job details locally

B
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Stores the job details as a local file.

Auto refresh

With this function enabled, Studio automatically refreshes all details of the executed

job on a timed basis.
Basic information page

Displays the basic information of a job, including its ID, Owner, status, start and end
time, computing resource usage, input, output, and so on. The basic information of
a running job is automatically refreshed on a timed basis. The input and output items

list the input and output tables of the job. Double-click a table name to view its details

Execution view

Execution view is the most commonly used tool to display the dependency between
Fuxi Job, Fuxi Task, and Operation. It also provides a series of auxiliary tools such as
job playback, progress view, heat map view, and so on. The execution view is useful

for troubleshooting problems.

The execution view can display job dependencies in three dimensions: the Fuxi Job
layer, Fuxi Task layer, and Operation layer. Click the breadcrumb or the up arrow
to switch between dimensions. By default, the dependency in the Fuxi Task layer is

displayed.

Note:
For non-SQL jobs, only those in the Fuxi Job and Fuxi Task layers can be displayed.

Operation layer jobs cannot be displayed.

- Fuxi Job layer:

Click the breadcrumb or the up arrow to switch between dimensions. By default,
the dependency in the Fuxi Task layer is displayed. Fuxi To open the Fuxi Job layer
, click the MaxCompute Job in the breadcrumb or the up arrow in the Fuxi Task
layer. Fuxi Job workers include the names, start times, and end times of Fuxi Tasks

. To go to the Fuxi Task layer, double-click any Fuxi Job worker.



- Fuxi Task layer:

In the event there is more than one Fuxi Job, the Fuxi Task layer of the last Fuxi Job
is opened by default. This layer can display the dependency, input/output tables,
and partitions of Fuxi Tasks. Once the job has ended, click the drop-down box in
the toolbar to switch between views, including those for progress, input and output
heat maps, and Task time and Instance heat maps. The progress view displays the
progress of completion for the worker. The heat map view uses colors to distinguis
h between different worker heats. Double-click any Fuxi Task to open its Operation

layer. Right-click to open the Operation layers of all Fuxi Tasks.

Contents of a Fuxi Task worker:

1 . Instance Count : a /b / c indicates that at a
certain point in time , the number of running

subtask instances is a , the number of completed

task instances is b , and the total number of task
instances is c .

2 .I/0 records : Similarly , this displays the number
of input records and output records at a certain
point in time .

3 . Percentage and orange progress bar : Indicates the
running status of the task . It is obtained by
analyzing  the running  subtask dinstances .

4 ., The line connecting subtasks shows the number of
output records . The arrow indicates the data flow
direction

- Operation layer

The Operation layer reveals how Fuxi Tasks run internally. By clicking a worker, all

Operation information is displayed.

Job playback

Studio supports the job playback function. The history of a job can be reviewed
within 12s, just like playing a media file. This function helps you understand the
running status of a MaxCompute instance in different time points, rapidly determine
the sub-task-level running sequence and time consumed, master the key path for

executing a job, and accordingly optimize sub-tasks that run slowly.

- Click > to start playing the job, and click > again to pause. You can also manually

drag the progress bar.



- The start time of the job is displayed on the left side of the progress bar, the playing

time in the middle, and the end time on the right.

Note:
The playback function only estimates the volume of 1/0 data at a certain point in
time by measuring the time, thereby determining the progress of completion. This
does not represent the actual volume of I/O data. Jobs with a running status do not

support playback.
Timeline view

Displays in the form of a Gantt chart detailed data for the distributed execution of a
job. You can adjust the display granularity to show all computing workers in a Gantt

chart.

Gantt charts can be used to display the time bottlenecks and long-tail workers of
running jobs. Multiple filters are also provided that help select the key paths, the

largest data worker, and the longest time worker for job execution.
Job details page
Mainly applies to SQL DML jobs, displaying their Fuxi Task lists and computing

worker lists on the compute cluster.

One job typically corresponds to one or more Fuxi Jobs. Each Fuxi Job is divided into
multiple Fuxi Tasks (stages), and each Fuxi Task comprises multiple Fuxi instances (

workers).

Right-click a Fuxi instance, and the displayed menu allows you to view the standard

output, standard errors, and Debug Info.

Analysis page

Displays the long-tail workers and skewed data workers of jobs. Displays worker

scatter plots and column charts to help diagnose job execution bottlenecks.

Scatter plots and column charts allow you to call the details view page from their

workers and check Fuxi instance details.



Results page

The results page displays different pages based on the job type and the parameters

configured at the time the job was submitted.

- Select statement and set odps.sql.select.output.format = HumanReadable. This
displays the result in text format

- Select statement but do not set the output format. This displays the result in table

format

- For scripts where data is exported to the table, the output table name and the link

that redirects to the table details are displayed

- For abnormal jobs, the results page limits the details on abnormalities

2.8 Tool integration

2.8.1 Integrate with MaxCompute client
MaxCompute Studio is integrated with the MaxCompute client program. You can open

the client on MaxCompute Studio.
Configure the client installation path

1. MaxCompute Studio contains the MaxCompute client of the latest version, which

is specified as the default client. You can also install the client of another version



by selecting Settings > MaxCompute Studio > SDK & Console on Intelli] IDEA and

adding the client program and path. Console download address

Settings & i — - ‘l‘
@\ \ MaxCompute Studio > SDK & Console Reset
Cppes el Esh oy MaxCompute Console Details
Keymap 1
Editor Installed Location: |\:\
Plugins Version: No valid Client mstalled in the specified path. Please check or download

Version Control

Build, Execution, Deployment

Languages & Frameworks

Tools

MaxCompute Studio
SDK & Console
MaxCompute SQL
Accounts

Maven Helper

m [ Cancel I I Apply ] [ Help ]




2. After setting is successful, the MaxCompute client version is displayed.

Settings

(Q. “ MaxCompute Studio > SDK & Console Reset

LRpeaancelAlES oy MaxCompute Console Details

Keymap —
Editor Installed Location: Di\develop\odpscmd_public Hi‘
Plugins Version: 0233

Version Control |

Build, Execution, Deployment
Languages & Frameworks
Tools

MaxCompute Studio
MaxCompute SQL

Accounts

Maven Helper

“ I Cancel ] l Apply I I Help I

Open the MaxCompute client

After the MaxCompute client installation path is set, you can open the client program

on MaxCompute Studio.



1. In the project browsing list, right-click a project to be opened and select Open in

Console.

1 MaxCompute Project Explorer #- 1+ Ehello,word.osq\ x gcnmpiled:helloiword,osqlisq\ x gtest,demo.osql * m studio-script-demo.iml x
|+ - 0E= 0 p

R meta_dev | :

FETal  Add project -
! CEFu Remove project -
: [ Re ekclcioich oo
7] meta Refresh meta select * from meta_dev.chai_common_sign;
1 Show|Modify project properties
Open in Console

\ | MaxCompute Consaole

iLALiyun 0DPS Command Line Tool

i Version @.22.2

! @Copyright 2015 Alibaba Cloud Computing Co., Ltd. ALl rights reserved.
! odps@ meta_dev
I

2. You can open multiple client programs by following the preceding steps.

MaxCompute Console

meta_dev  meta_dev (1)

mpute Job [

5 Aliyun 0DPS Command Line Tool

5 Version 0.22.2

“@Copyright 2015 Alibaba Cloud Computing Co., Ltd. ALl rights reserved.
odps@ meta_dev

W 2: Favorites

E» 6: TODO +/. MaxCompute Console /A MaxCompute Compiler 1§, 9: Version Control Terminal %A Running Info

2.9 Configure options

2.9.1 Configure MaxCompute Studio
After the MaxCompute Studio plug-in is installed, you can find configuration items

of MaxCompute Studio on the left bar of the Settings page of Intelli] IDEA. For more



information about how to open the Intelli] IDEA configuration page, see IntelliJ IDEA

Documentation.
MaxCompute Studio configuration option page

The MaxCompute Studio configuration option page provides the following configurat

ion items:
1. Path for storing the local metadata base

Specifies the path for locally storing metadata of a MaxCompute project. On

MaxCompute Studio, the metadata is stored in the hidden directory . odps .
studio / meta of thelocal user directory by default.

2. Version update options

- You can use the Automatically checks for new version check box to control
whether MaxCompute Studio automatically checks for new version updates.

- You can use the Check new versions button to manually check new versions.
After you click this button, if a new version is available, the Install new version
button is displayed. You can click this button to install the new version, and

restart Intelli] IDEA after the installation is complete.
SDK and Console configuration option page

The SDK and Console configuration option page provides the following configuration

items:
1. Path for installing a MaxCompute client

Specifies the path for local installation of MaxCompute client. MaxCompute Studio
detects the version of the MaxCompute client installed in the path. If detection

fails, an error message is prompted.

Note:
MaxCompute Studio later than the 2.6.1 version provides the latest MaxCompute
client. You do not need to specify the path. If you must use a MaxCompute client

of a specific version, you can specify the path.
MaxCompute SQL configuration option page

The MaxCompute SQL configuration option page provides the following configuration

items:


https://www.jetbrains.com/help/idea/2016.3/accessing-settings.html
https://www.jetbrains.com/help/idea/2016.3/accessing-settings.html

1. Enable syntax coloring

Select Enable syntax coloring to enable the syntax highlighting feature.

2. Enable code completion

Select Enable code completion to enable the automatic code complementing

feature.

3. Enable code formatting

Select Enable code formatting to enable the code formatting feature.

4. Compiler options

These are global default compiler options. The following options can be separately

set for each file on the toolbar of the SQL compiler.
- Compiler Mode

- Statement Mode: In this mode, the compiler compiles and submits a single
statement of an SQL file as a unit.

- Script Mode: In this mode, the compiler compiles and submits an entire SQL

file as a unit. NOTE: Script Mode enables the compiler and optimizer to optimize the
execution plan and improve the overall execution efficiency. This mode is in the test phase

now.

- Type System

- Legacy TypeSystem: Indicates the type system of original MaxCompute.

- MaxCompute TypeSystem: Indicates the new type system introduced by
MaxCompute 2.0.

- Hive Compatible TypeSystem: Indicates the type system in Hive compatibility
mode introduced by MaxCompute 2.0.

- Compiler Version

- Default Version: Indicates the default version of the compiler.

- Flighting Version: Indicates the experimental version of the compiler, which

includes new features of the compiler being tested.
Account configuration option page

You can add or manage accounts used to access MaxCompute on the Account

configuration option page. For more information, see User authentication.



You must specify an account on MaxCompute Studio to access a MaxCompute project
and run or submit jobs. MaxCompute Studio currently supports the following

account type:
- Alibaba Cloud account (AccessKey)
Add an account
On the Account configuration option page, follow these steps:

1. Click + or press Ctrl - N .

2. Select the account type Aliyun Account by AccessKey.
3. In the displayed Add Account window, set the following items:

Account  Name :Indicates the name of the account on MaxCompute Studio.

Using properties file :Read the AccessKey ID and AccessKey Secret

from the configuration file.

- Select the configuration file conf / odps_confi g . ini afteryou

process User authentication.

Using  properties :Manually enter the AccessKey ID and AccessKey
Secret.
- Access Id :Enter the AccessKey ID of your Alibaba Cloud account.
- Access Key :Enter the AccessKey Secret of your Alibaba Cloud account.

Add MaxCompute project [ =2 |

Odps.ini files need to be

Connection

Properties File:

* End Point:

downloaded in advance to initialize
iguration items such as AK/Endpoi

Setting 2

loadiMaxCompute Clientconf\odps_config.ini

AK Account: sing AK account to initialize AK, yau can
click on the right + to add.

* Access Id: LT AdS it | 7|HO
* Access Key: OAPref Tl M uliitr Dbl A0 2R r 2| JEf
* Project NMame: | MySecondProject2

http://service.odps.aliyun.com/fapi




4. Click OK to complete addition. Then, the account will be displayed in the Account

list on the Account configuration option page.
Delete an account

On the Account configuration option page, follow these steps: (This operation only
deletes the account configuration on Studio configuration, which does not affect your

account.)

1. Select the account to be deleted in the account list.
2. Click -.
3. In the displayed dialog box, click OK.

Modify the AccessKey of an account
On the Account configuration option page, follow these steps:

1. Select the account to be deleted in the Account list.
2. Click the pencil icon.
3. In the displayed Edit Account window, modify the account information. The

content is similar to that in the preceding section Add Account.

View the opening and connection of MaxCompute Region and the settings of

Endpoint, see Endpoints and Data Centers.



3 Eclipse Plugins

3.1 Install

To facilitate the development work with Java SDK of MapReduce and UDF, MaxCompute
provides Eclipse Development Plug-in. This plug-in can simulate the running process
of MapReduce and UDF to provide local debugging methods and simple template

generation.

Note:

- Current versions of Eclipse Neon are likely to cause plug-in loading to fail, please
use the Eclipse Luna version.

- To download this plug-in, click Here.

- Unlike the local running mode provided by MapReduce, Eclipse plug-in cannot
synchronize data with MaxCompute. Data must be manually copied to the

warehouse directory of Eclipse plug-in.

After downloading the Eclipse plug-in, decompress the software package to find the

following jar:
odps - eclipse - plugin - bundle - 0 . 16 . 0 . jar

Place the plug-in into the subdirectory plugins in Eclipse installation directory. Start

the Eclipse plug-in, and click Open Perspective in the upper right corner.As follows.


https://docs-aliyun.cn-hangzhou.oss.aliyun-inc.com/cn/odps/0.0.90/assets/download/odps-eclipse-plugin-bundle-0.16.0.zip

MaxCompute Tools and Downloads / 3 Eclipse Plugins

0= Outline 53 ‘

An outling is not available.

After clicking the button, the following dialog box is displayed.As follows.
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G\IS Repository Exploring
f‘sﬁ Debug

[z Git

Ef-.]a'.ra {default)

E‘Jda'.ra Browsing

8 J Java Type Hierarchy
== Plug-in Development
PD Resource
EDTearn Synchronizing

]

Cancel OK

Select ODPS and click OK. The MaxCompute icon appears in the upper right corner,
indicating that the plug-in takes effect.As follows.

]f B &'Java &k ODPS

0= Outline 53 = O

An outline is not available.



3.2 Create a project

You create a MaxCompute project in two following ways.
Method 1

Select File > >New > > Project > > MaxCompute > > MaxCompute Project to create

the project (in the example, use ODPS as the project name),as follows.

Mew Alt+Shift+M » .;-}_a ODPS Project
Open File... 2% Java Project
[} Open Projects from File System... ™ Project..
Close Ctrl+W | @ MapReduce Driver
Close All Ctrl+Shift+W | @@ Mapper
Save Cirl+s | @ Reducer
@ Save As.. ure  UDF
Save Al Ctrl+shift+s |l UDTF
Revert Y Package
& Class
M
ove & Interface
[¥] Rename.. F2 @ Enum
&' Refresh F5 .
@ Annotation
Convert Line Delimiters To (3 .
#7 Source Folder
Print... Ctrl+P | 4% Java Working Set
e 9 Folder
= 7 File
=" Untitled Text File
Properties Alt+Enter
™ Example...
1 DownloadUtils.class [com.aliyun.odp...]
=
2 _schema__ [odps/warehouse/.../wc_inl] 1 Other.. Ctrl+N
—PrOTECT: EXAMpIE Profect
3 UDFExamplejava [odps/examples/com/..]
4 _schema_ [odps/warehouse/.../wc_in2]
Switch Workspace b les to display at this time.
Restart
Exit

After creating MaxCompute project, the following dialog box is displayed. Enter
the project name, select the MaxCompute client path, and click FinishFinish. The

MaxCompute client needs to be downloaded in advance.As follows.



& New ODPS Project Wizard

Create ODPS project

= Preferences

[Projecl name: odps

Use default location
D:\Users\Administrator\WorkSpace\odp4

Config ODPS console installation path

[-@- Use default ODPS conscle installation path I
() Specify ODPS console installation path

Version: 0.29.4

@

@ Note:

@

m

ODPS Settings

= [E]=] .
Quick Access &
= ==
Config ODPS console installation path
Config ODPS console installation path
[DrmmmE T e | Browse...
Version: 0.29.4
Run Made
@ Local Remote
limit record count of downloaded
100 (0~10000)
[[] Retain local job temp directory
’Restore Defaults] ’ Apply ]

[Apply and Close] ’ Cancel ]

For more information about MaxCompute client, see Client.

After creating the project, the following directory structure is displayed in the left

Package Explorer,as follows.



MaxCompute

Tools and Downloads / 3 Eclipse Plugins

I Package Explorer i3 2 ¥ = 0

ngndps
2 src

» =, JRE System Library [Java SE 7 [1.7.0_71]]

b =, Referenced Libraries
¥ #examples
YL{E com.alivun.odps. examples.mr
> dl:ﬂ Resource.java
> [J] WordCount.java
YL{E com.aliyun.odps.examples. udf
> m UDAFExample.java
» 1J| UDAFResource.java
[ |I] LUDFExample.java
> dl:ﬂ UDFResource.java
» [J] UDTFExample.java
[ d@ LUDTFResource java
»> EE com.aliyun.odps.examples.udf.test
[=temp
¥ = warehouse
¥ = example_project
b= __resources
¥ = __tables__
P = rs_out
P =we_int
= we_in?
P [=we_out
Readme

Method 2

Click New in the upper left corner,as follows.
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After the dialog box is displayed, select ODPS Project and click Next,as follows.

MNew

Select a wizard F<>

b

‘Wizards:

| type filter text

(5 Class

¥ Interface
(£ Java Project
-ﬁda\ra Project from Existing Ant Buildfile
1 Plug-in Project
b (= General
b =CVS
» = Git
b= Java
¥ = 0DPS
W Mapper

ier
't,'.- ODPS Project
eaucer
¥ upar

utF UDF

B votF

P = Plug-in Development
P = User Assistance

@ <Back | Next> ||| cancel | Finish
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The subsequent operations are similar to Method 1.

The installation of MaxCompute Eclipse plugin is completed. You can use this plugin
to write MapReduce or UDF programs. For more information about MapReduce, see

MapReduce.For more information the UDF programming, see UDF.

3.3 MapReduce

This article shows you how to use Eclipse to develop and run MapReduce programs.

Select WordCount example in MaxCompute project,as follows.

% Package Explorer 2 == ¥ = O[] WordCountjava 52 =
g p o
4 4% odps @ 1 package com.aliyun.odps.examples.mr;
m 2
4 sre 3® import java.io.IOExceptionj
£ od p ] P
odps 17
=\ JRE System Library [Java] 18 _
. =) Referenced Libraries :2 B TEEE sz@MapReduce s B mewismn:
4 B examples 21 public class WordCount {
. B com.aliyun.odps.examples.graph 22
2 i com.aliyun.odps.examples.mr :? public static class TokenizerMapper extends MapperBase {
24
\J| Resource java 25 Record word;
[J] UserDriverjava 26 Record one;
m UserMapper java 4’-‘ Counter gCnt;
[J] UserReduce,java 20 @0verride
m WordCountjava A 3p public void setup(TaskContext context) throws IOException {
. com.alyun.odps.examples.udf 31 word = context.createMapOutputKeyRecord();
. ; 32 one = context.createMapOutputValueRecord();
- B com.aliyun.odps.examples.udf.test 33 one.set(new Object[] {1L});
(= temp 34 glnt = context.getCounter("MyCounters”, "global counts");
- [= warehouse 33 }

Right-click WordCount.java and choose Run As -> ODPS MapReduce, as follows.



[# Package Explorer 52

4 % odps
B src

> m JRE System Library [Java)

» m) Referenced Librari

4 ;# examples

> com.aliyun.odps
4 [ com.aliyun.odps
> 1J] Resourcejav,
> | [J] WerdCount,
i com.aliyun.odps
> H com.aliyun.odps

(= temp
> [ warehouse

[ word Countjava &2

1 package com.aliyun.odps.examples.mr;

3@ import java.io.IOException;[]

X & (i

GE

New

Open

Open With

Open Type Hierarchy
Show In

Copy
Copy Qualified Name
Paste

Delete

Remave from Context
Build Path
Source

Refactor

Import...
Export...

References

Declarations

Refresh

Assign Working Sets...

Coverage As

Debug As
Validate

Restore from Local History...

Team

Compare With

F3

F4
Alt+Shift+W »

Ctrl+C

Ctrl+V
Delete

Ctrl+Alt+Shift+ Down
3
Alt+Shift+5 ¢
Alt+Shift+T »

F3

s TokenizerMapper extends MapperBase {

p(TaskContext context) throws I0Exception {
.createMapOutputKeyRecord();
createMapOutputValueRecord();

gect[] {1L});
.getCounter("MyCounters"”, "global_counts");

= & Console 2
Mapreduce|Graph] D:\Program Files\Java\jre\bin\javaw.exe (20185E12F

<

1 Java Application Alt+Shift+X, J
[{} 2 ODPS Mapreduce|Graph ]

uk 3 ODPS UDF|UDTF|UDAF

Run Configurations...

After the dialog box is popped up, select example_project and click Finish, As

follows.
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" ™

& ODPS MapReduce|Graph Run Configuration =RERES

ODPS Mapreduce|Graph Run Configuration

Class

com.aliyun.odps.examples.mrWordCount

Run Mode

@ Local Remote

Select ODPS Project

MySecondProject2

Femaove
Fesources
Program Arguments
@ Einish Cancel

After running is completed, the following result is displayed,as follows.
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& Console 58 " R EHEE@'@ A &5 = 0

Run User-defined MapReduce Program

ines/|dk1.7.0_71.Jdk/Contents/Home/binfava (201551 F27H F43:42:38)

<terminated> WordCount [ODPS D ] /Library/Javal. Vir

{€8: Reload warehouse table:wc_out

Summary :
Inputs:

example_project.wc_inl,example_project.wc_in2/pl=2/p2=1

Outputs:
example_project.wc_out

M1_example_project_LOT_@_9_0@_job@
Worker Count: 2
Input Records:
input: 7 (min: 3, max: 4, avg: 2)
Output Records:
R2_1: 17 (min: &, max: 9, avg: &)
R2_1_example_project_LOT_@_8_8_job@
Worker Count: 1
Input Records:
input: 5 (min: 5, max: 5, avg: 5)
Qutput Records:
R2_1F5_9: 5 (min: 5, max: 5, avg: 5)
counters: 1@
map-reduce framework: 7
combine_input_groups=5
combine_output_records=5
map_input_bytes=87
map_input_records=7
map_output_records=17

reduce_output_[example_project.wc_out]_bytes=37
reduce_output_[example_project.wc_out]_records=5

user defined counters: 3
mycounters
global _counts=22
map_outputs=17
reduce_outputs=5

oK
Instanceld: mr_20150127074239_358_27772

Right-click src directory. Select New -> > Mapper,as follows.
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i

% ODPS Project
1% Java Project
= Project...

& MapReduce Driver 3E 7 [1.7.0_71]]
@ Reducer

ue UDF

B UDTF

#¥ Package

& Class

& Interface -

& Enum void

@ Annotation les.udf

&% Source Folder fes.udf.test
14 Java Working Set

% Folder

[ File

' Untitled Text File

les.mr

= Other... $EN

After selecting Mapper, the following dialog box is displayed. Input the name of

Mapper class and click Finish.as follows.
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& New Mapper o |[= ] ==

Mapper

Create a new Mapper implementation.

Source folder: odpsfexamples Browse...

Package: com.aliyun.odps.examples.mr Browse...

Mamme: UserMapper
Superclass: com.aliyun.odps.mapred.MapperBase Browse...
Interfaces: Add...
Bemowve
?\' Finish Cancel

The file UserMapper.java is generated in the src directory in Package Explorer. The

content of this file is a template of Mapper class,as follows.

package odps ;
import java . io . IOExceptio n ;
import com . aliyun . odps . data . Record ;
import com . aliyun . odps . mapred . MapperBase ;
public class UserMapper extends MapperBase {
@ Override
public void setup ( TaskContex t context ) throws

IOExceptio n {

@ Override
public void map ( long recordNum , Record record ,
TaskContex t context )
throws IOExceptio n {

@ Override
public void cleanup ( TaskContex t context ) throws
IOExceptio n {



In the template, the configured package name defaults to odps. You can modify it
according to your actual requirement. Write the template content as follows,as

follows.

package odps
import java . io . IOExceptio n ;
import com . aliyun . odps . counter . Counter ;
import com . aliyun . odps . data . Record ;
import com . aliyun . odps . mapred . MapperBase ;
public class UserMapper extends MapperBase {

Record word ;

Record one ;

Counter glnt

@ Override

public void setup ( TaskContex t context ) throws

IOExceptio n {

word = context . createMapO utputKeyRe cord ();
one = context . createMapO utputValue Record ();
one . set ( new Object [] { 1L 1);

gCnt = context . getCounter (" MyCounters ", "

global_cou nts ");

@ Override
public void map ( long recordNum , Record record ,
TaskContex t context )
throws IOExceptio n {

for ( 1int i = 0 3; i < record . getColumnC ount
O; 1 ++) {
String [] words = record . get ( i ). toString ().
split ("\\ s +");
for ( String w : words ) {
word . set ( new Object [] { w 13});
Counter cnt = context . getCounter (" MyCounters

", " map_output s ");
cnt . dincrement ( 1 );
gCnt . dincrement ( 1 );
context . write ( word , one );

@ Override
public void cleanup ( TaskContex t context ) throws
IOExceptio n {

Similarly, right-click src directory and select New -> > Reduce:,as follows.



rd =

& Mew Reducer =

[g]
(X

Reducer

Create a new Reducer implementation.

Source folder: odps/examples Browse...

Package: com.aliyun.odps.examples.mr Browse...

Mame: IUserReduce I
Superclass: com.aliyun.odps.mapred.ReducerBase Browse...
Interfaces: Add..
Remove
(?:' Finish Cancel |

Input the name of Reduce class. (In this example, use UserReduce as the class name.)

In Package Explorer, a file name UserReduce.java is generated in the src directory.

This file content is a template of Reduce class. Edit the template,as follows.

package odps ;
import java . io . IOExceptio n ;
import java . util . Iterator ;
import com . aliyun . odps . counter . Counter ;
import com . aliyun . odps . data . Record ;
import com . aliyun . odps . mapred . ReducerBas e ;
public class UserReduce extends ReducerBas e {
private Record result ;
Counter gCnt ;
@ Override
public void setup ( TaskContex t context ) throws
IOExceptio n {
result = context . createOutp utRecord ();
gCnt = context . getCounter (" MyCounters ", "
global_cou nts ");

@ Override
public void reduce ( Record key , Iterator < Record >
values , TaskContex t context )



throws IOExceptio n {

long count = 0 ;
while ( values . hasNext ()) {
Record val = values . next ();

count += ( Long ) wval . get ( 0 );

result . set (@, key . get ( 0 ));

result . set (1, count );

Counter cnt = context . getCounter (" MyCounters ", "
reduce_out puts ");

cnt . dincrement ( 1 );

gCnt . dincrement ( 1 );

context . write ( result );

@ Override
public void cleanup ( TaskContex t context ) throws
IOExceptio n {

Create main function: right-click src and select New -> > MapReduce Driver. Enter
Driver Name (in this example, use UserDriver as the name), Mapper and Reduce (in
this example use UserMapper and UserReduce as corresponding names) and click

Finish. The file MyDriver.java is also displayed in src directory,as follows.



& New MapReduce Driver = |[= ]2
MapReduce Driver
Create a new MapReduce driver.
Source folder: odps/examples
Package: com.aliyun.odps.examples.mr
[ Mame: UserDiriver
Superclass: java.lang.Object
Interfaces: Add..
Remove
Mapper: UserMapper Browse...
Reducer: UserReduce Browse...
?\' Finish ] | Cancel
Edit the driver content,as follows.
package odps ;
import com . aliyun . odps . OdpsExcept -ion ;
import com . aliyun . odps . data . TableInfo ;
import com . aliyun . odps . examples mr . WordCount .
SumCombine r ;
import com . aliyun . odps . examples mr . WordCount . SumReducer
5
import com . aliyun . odps . examples mr . WordCount .
TokenizerM apper ;
import com . aliyun . odps . mapred JobClient ;
import com . aliyun . odps . mapred RunningJob ;
import com . aliyun . odps . mapred conf . JobConf ;
import com . aliyun . odps . mapred utils . InputUtils ;
import com . aliyun . odps . mapred utils . OutputUtil s ;
import com . aliyun . odps . mapred utils SchemalUtil s ;
public class UserDriver
public static  void main ( String [] args ) throws
OdpsExcept dion {
JobConf  job = new JobConf ();
job . setMapperC Tlass ( TokenizerM apper class );



job . setCombine rClass ( SumCombine r . class );

job . setReducer Class ( SumReducer . class );

job . setMapOutp utKeySchem a ( SchemaUtil s . fromString
(" word : string "));

job . setMapOutp utValueSch ema ( SchemaUtil s
fromString (" count : bigint "));

InputUtils . addTable (
TableInfo . builder (). tableName (" wc_inl "). cols (

new String [] { " col2 ", " col3 " }). build (), job );
InputUtils . addTable ( TableInfo . builder (). tableName ("

wc_in2 "). partSpec (" pl =2 / p2 =1 "), build (), job );
OutputUtil s . addTable ( TableInfo . builder (). tableName

(" wc_out "). build (), job );
RunningJob rj = JobClient . runJdob ( job );

rj . waitForCom pletion ();

Run MapReduce program. Right-click UserDriver.java and select Run As -> > ODPS
MapReduce, the following dialog box is displayed,as follows.
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-~

& ODPS MapReduce|Graph Run Configuration o= | =]

CDPS Mapreduce|Graph Run Configuration

Class

com.aliyun.odps.examples.mr.UserDriver

Run Mode

@ Local Remote

Select ODPS Project

MySecondProject?

Remove

Resources

Program Arguments

@ | Fnish || Ccancel

Select example_project as the MaxCompute Project and click Finish to run

MapReduce program in the local,as follows.
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= console 2% ® % e & & # E-ri-= 10

<terminated> UserDriver [ODPS Mapreduce] /Library/JavasJavaVirtualMachines/jdk1.7.0_71.jdk/Contents/Home/bin/java (2015515278 F94:22:42)

Summary :
Inputs:

example_project.wc_inl,example_project.wc_in2/pl=2/p2=1
Qutputs:

example_project.wc_out

M1_example_project_LOT_B_B_8_jobd
Worker Count: 2
Input Records:
input: 7 (min: 3, max: 4, avg: 3)
Qutput Records:
R2_1: 17 (min: &, max: 9, avg: 8)
R2_1_example_project_LOT_B8_90_2_job@
Worker Count: 1
Input Records:
input: 5 (min: 5, max: 5, avg: 5)
Qutput Records:
R2_1F5_9: 5 (min: 5, max: 5, avg: 5)
counters: 1@
map-reduce framework: 7
combine_input_groups=5
combine_output_records=5
map_input_bytes=87
mop_input_records=7
map_output_records=17
reduce_output_[exomple_project.wc_out]_bytes=37
reduce_output_[example_project.wc_out]_records=5
user defined counters: 3
mycounters
global_counts=22
map_outputs=17
reduce_outputs=5

oK
Instanceld: mr_20150127082243_694_27864

If the output is the same as in the preceding figure, it indicates that local operation
runs successfully. The output result is saved in the warehouse directory. Refresh

MaxCompute project,as follows.

[

t2 Package Explorer 22 B ¥ = B[} WordCountay [J] UserReducejava  [J] UserDriverjava R_000000 | N .| EEEE I

v ¥ odps AZ,4
¥ @ 3,4
¥ B odps threel, 3
» [J] UserDriverjava three2,3
three3,3
b [J] UserMapper.java
» [J] UserReduce.java
» = JRE System Library [Java SE 7 [1.7.0_71]]
» =) Referenced Libraries
v gg examples
¥ [ com.aliyun.odps.examples.mr
» [J| Resource java
¥ [J] WordCount.java
¥ (& WordCount
» GF sumCombiner
» GF sumReducer
» @TokenizerMapper
& main(String[]) : void
bg} com.aliyun.odps.examples.udf
> mcom‘allyun‘odps.axamplﬂs‘udl.(asl
= temp
¥ = warehouse
¥ [ example_project
V(= resources
» (Ztable_resourcet
» [=table_resource2
file_resource.txt
¥ [=_tables
» = rs_out
» =we_int
P [=wc_in2
¥ [=we_out
__schema__
R_000000 El Console 32 *®
|5/ Readme

<terminateds UserDriver [0DPS Mapreduce] /Library/Java/JavaVirtualMachines/jdk1.7.0_71.jdk/Gontents/Home/bin/java (201551 527H TT4:22:42)
TEE: KELOO0 WArenoUSE TODLE:WC_out

Summary :
Inputs:
example_project.wc_inl, example_project.wc_in2/pl=2/p2=1

Writable Insert 1:1
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wc_out is the output directory and R_000000 is the result file. By local debugging,

the result is confirmed to be correct and you can package MapReduce program using
Eclipse export function. After itis packaged, upload the jar package to MaxCompute.
For more information how to run MapReduce in distributed environment, see Quick

Start.

After the local debugging is completed, you can package the codes in jar package
using Eclipse Export function, provided for subsequent distributed environment. In
this example, the package name is mr-examples.jar. Select the src directory and click

Export,as follows.

v i odps A2,4
e — 42 4
b =, JRE System Library [Java SE 7 [ New [ 3
b =5 Referenced Libraries Go Into

¥ [ #examples

1’I-Ecnrn.ali':.run.ndps.examples.ml 'Dpan in New Window

» [J] Resource java Open Type Hierarchy F4
¥ [J] WordCount.java Show In NEW  »
¥ @}Wﬂrdcnu nt
» (&7 SumCombiner i=| Copy #EC
b (&F sumReducer &= Copy Qualified Name
2 C TokenizerMapper :En Paste 3\
GS main{String[]) : void )
II-Eccnm.aliyun.ﬂdps.examples.ud X Delete =
F £H com.aliyun.odps.examples.ud Build Path >
- g:::rzmus& Source S >
¥ (& example_project Refactor NET >
7= resources gy Import...

b = table_resourcel

> table rsourcez I L

file_resource.txt

¥ = __tables w{h Refresh F5
b (= rs_out Assign Working Sets...
b = we_int
¥ = we_out Run As >
|=| __schema Team »
|=| R_000000 Compare With >
|=| Readme Restore from Local History...

<& Import from Repository...

Properties 3e1

Select Jar File as an export mode,as follows.
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(oo e o

3| | Select ﬁ
Export resources into a JAR file an the local file system. M

Select an export destination:

|type filter text |

[ (= General
> (= Install

. Runnable JAR file
I (= Plug-in Development
I (= Run/Debug
I = Team

@ | = Back || MNext = | | Finish | I Cancel ]

You must only export the package in src. The Jar File name must be specified as mr

- examples . jar ,as follows.

Smbon % o ok

JAR File Specification ( 2
(1) The export destination will be relative to your workspace. S J
4 (m %% oDPs .classpath
4 [ G src project

[¥] i com.aliyun.odps.mapred,
B 2 examples
= mr_local_jobs
B = warehouse

4| 0 | 3

Export generated class files and resources
Export all output folders for checked projects
Export Java source files and resources

Export refactorings for checked projects. Select refactorings...

AR fle: v | Browse..

ptions:
Compress the contents of the JAR file
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Click Next to export the jar file.

If you want to simulate new Project creation in the local, you can create a
subdirectory (has same level with example_project) in the warehouse directory. The

directory hierarchy structure is shown as follows.

< warehouse >
| ____exampl e_project ( Project Dirctory )
____ < __tables__ >
| | __table_na mel ( non - partition table )
T data ( File )

| | | ____ < __schema__ > ( File )

| | __table_na me2 ( Partition Table )

| | —___ partition_ name = partition_ value ( partition
directory )

| || —___ data ( file )

| | ____ < __schema__ > ( file )

< __resource s__ >
| ___table_r esource_na me ( table resource )
| | ____ < __ref__ >

| ___ file_resou rce_name ( file resource )

schema Example,as follows.

Non - partiton table

project = project_na me

table = table_name

columns = coll : BIGINT , col2 : DOUBLE , col3 : BOOLEAN , col4
DATETIME , col5 : STRING

Partition table

project = project_na me

table = table_name

columns = coll : BIGINT , col2 : DOUBLE , col3 : BOOLEAN , col4
DATETIME , col5 : STRING

partitions = coll : BIGINT , col2 : DOUBLE , col3 : BOOLEAN , col4
DATETIME , col5 : STRING

Note

Currently , the following five data formats are

supported : bigint , double , boolean , datetime , string , which
correspond to the data types in java : - long , double ,

boolean , java . util . Date , java . lang . String .

data Example,as follows.

1,1.1, true, 2015 - 06 - @4 11 : 22 : 42 896 , hello
wor ld

\ N L\ N\ N LN G\ N

Note :



The time format is accurate to the millisecon d
level and all types are represente d NULL by '\ N

Note:

- If MapReduce program runs in the local, the default is to search corresponding
tables or resources from the warehouse directory. If the tables or resources do
not exist, corresponding data will be downloaded from the server and saved in
warehouse. Then run MapReduce in the local.

- After running MapReduce is finished, refresh the warehouse directory to view the

generated result.

3.4 UDF

This section describes how to develop UDF with the Eclipse plug-in and how to run

UDF on local. The preparation and implement process is similar to UDF. You can see



the example of UDF. MaxCompute Eclipse plug-in provides two methods to run UDF:

Menu Bar and run by right-clicking it.

Run UDF using Menu Bar

1. Select Run > > Run Configurations- - from the menu bar and the following dialog

box appears,as follows.

& Run Configurations

L

|

Create, manage, and run configurations

>

L [T ]
|_|_5.§|x|E|:=P'

type filter text

[T Java Application -
cco il
fileupload
hellowarldapp
maggieTest
test

Ju JUnit

m2 Maven Build

ik ODPS Mapreduce
& Mydriver
% Resource
% UserDriver
% WordCount

ue ODPS UDF|UDTHUDAF

uf Mew_configuration

m

ue UDFExample

Mame: Resource

® Main™_ODPS Conﬂgﬂ = Arguments\l = JREW U Classpaﬂﬂ ;-] Environmenq = Common}

Project:

odps project

Main class:
com.aliyun.odps.examples.mr.Resource

[[]1nclude system libraries when searching for a main class
[[JInclude inherited mains when searching for a main class

[] Stop in main

uf UserUDF
Juy Task Context Test m
€| i +
Apply Revert
Filter matched 19 of 19 items BE =
® Run ] ’ Close




2. You can create a new Run Configuration. Select the UDF class and type to be
executed, select MaxCompute Project and enter the information of input table. Aa

follows.

ODPS UDF|UDTF|UDAF Run Configuration

Class

com.aliyun.odps.examples.udf. UDFExample

Select ODPS Project

example_project

Add
Edit
Remove
Input Table
Table: we_in2
Partitions: | p2=1,pi=2 ie: p1=1,p2=1 (default all partitions)
Columns: |cole,colb.cola ie: c1,c2,c3 (default all columns)
fay .
I:E'JI Cancel Finish

In the preceding configuration, Table indicates the input table of UDF.
Partitions indicates the partitions from which the data is read, separated
by commas. Columns indicates the columns, which are considered as the

parameters of UDF to be introduced. The columns are separated by commas.



3. Click Run to run the program and the running result is displayed in the console,as
follows.

Bl console 2 X % & GE&\&
<terminated> udf [ODPS UDF|UDTF|UDAF] /home/shihai/lib/java/bin/java (Dec 12, 2014 7:32:23 PM)
5552s:three3, threel, three2

55525:three3, threel, three2
55525:three3, threel, three2

Run by right-clicking

1. Select a udf.java file (such as UDFExample.java) and right-click it. Then select Run
As >>Run UDF|UDAF|UDTF:

CODPS3 UDF|UDTF|UDAF Run Configuration

Class

com.aliyun.odps.examples.udf. UDFExample

Select ODPS Project

example_project
Add

Edit
Remove

Input Table

Table: we_in2

Partitions: | p2=1,p1=2 ie: p1=1,p2=1 (default all partitions)

Columns: |cole,colb.cola

ie: ¢1,c2,c3 (default all columns)

@j Cancel Finigh




2. The configuration information is shown as follows.

CODFS UDFUDTF|UDAF Run Configuration

Class

com.aliyun.odps.examples.udf. UDFExample

Select ODPS Project

example_project

Add
Edit
Remove
Input Table
Table: we_ing
Partitions: | p2=1,p1=2 ie: p1=1,p2=1 (default all partitions)
Columns: | colc,colb,cola ie: ¢1,c2,c3 (default all columns)
'ﬁtﬁl Cancel Finish

In the preceding configuration, Table indicates the input table of UDF.
Partitions indicates the partitions from which the data is read, separated

by commas. Columns indicates the columns, which are considered as the

parameters of UDF to be introduced. The columns are separated by commas.

3. Click Finish to run UDF and get the output result.
Running customized UDF program

Right-click a project and select New > >UDF (or select the menu bar File > > New > >
UDF).



Enter the UDF class name and click Finish. Generate a Java file in corresponding src

directory with the same name as this UDF class. Edit this java file as follows.

package odps ;

import com . aliyun . odps . udf . UDF ;

public class UserUDF

extends UDF {

* project : example_pr oject

*

table : wc_1inl
* columns : coll ,

col2

public String evaluate ( String

return " ss2s " + a + "," + b ;

a , String b ) {

Right-click this java file (such as UserUDF.java) and select Run As -> ODPS UDF|UDTF|

UDAF:
=¥ o S . ;
{2 Package Explorer 52 = O UDFExample.java [J] UserUDFjava 3
v i odps package odps;
¥ Esrc
v # odps import com.aliyun.odps.udf.UDF;
> DF extends UDF {
» =i JRE System Library [Java SE 7 [1.7.0_71]]
b = Referenced Libraries Open F3
¥ (Bexamples Open With p [example_project
b_[-E}cnm.alfyun.odps.examples.mr Open Type Hiararchy Fa Linl
7_[-Ecom.alwun.odps.examples.ud( sh I T®W > coll,col2
» [J] UDAFExample java L
L 4 m UDAFResource.java =G q .
1= L0l 8C
> m UDFExample.java u;' Py . gs?‘:ﬂlu:tjcat:l:gb?' String b)Y £
» [J| UDFResource.java 55 Copy Qualified Name ’ ’ ’
» [J] UDTFExample.java [ Paste BY
¥ )| UDTFResource.java 3 Delete =
» EE}com.aliyun.odps.examples.ud(.test
=temp Build Path >
P [= warehouse Source NHS >
Refactor T >
g2 Import...
iy Export...
References >
Declarations » - UDF|UDTFUDAF) /Library/JavaldavaVirtual
«* Refresh F5
Assign Working Sets...
Debug As >
Run As > [f5 1 ODPS UDF|UDTF|UDAF
Team >
Compare With > Run Configurations...
Replace With >

Restore from Local History..

Properties

Configure the following dialog box,as follows.

I



ODPS UDF|UDTF|UDAF Run Configuration

Class

odps. UserUJDF

Select ODPS Project

example_project

Add
Edit
Remove
Input Table
Table: wo_ind
Partitions: ieg: p1=1,p2=1 (default all partitions)
Columns: | coll,col2 ie: ¢1,c2,c3 (default all columns)

@ Cancel Finish

Click Finish to get the result:

ss2s ¢ Al , A2
ss2s : Al , A2
ss2s : Al , A2
ss2s : Al , A2

Only the operation instance of UDF is described in this section, and the way of UDTF

operating is basically similar to the UDF.



3.5 Graph

After creating a MaxCompute project, you can write Graph program and complete the

local debugging according to the following steps.

In this example, PageRank .

the debugging. Select PageRa

java provided by the plug-in is selected to complete

nk . java inexamples, as follows.

I
P

Refactor

m
y

/ / |

p

fod
P

t

2 WorkSpace - odps/,
Ele  Edit

-

Source

@ iHF-O0-Q-HE-IBO S

Navigate Search Project Run

% Package Explorer &2 = %= ‘ @ Y= 0
4 f% odps
8 src

> ®) JRE System Library [Java]

> @) Referenced Libraries

0w ke

®

4 (B examples

o]
I
> i

> i com.aliyun.odps.examples.udf

com.aliyun.odps.examples.graph
[J] Kmeans java

J| PageRanl-c.java]

[J] §55Pjava

com.aliyun.odps.examples.mr

(R

@

oo

> 4 com.aliyun.odps.examples.udf.test

=)

(= temp

> [= warehouse

[~

WL L L L L L R R PRI R R R R R R
" x

v

Right-click and select Debug A

[J] PageRankjava i

fgraph/PageRank.java - Eclipse

Window Help

-9

% P - Bl - o

8| T

Bl vt o =

package com.aliyun.odps.examples.graph;

 import java.io.IOException;[]

Set program arguments:
pagerank_in pagerank out

*y

public class PageRank {
= public static class PageRankVertex extends

Vertex<Text, DoubleWritable, NullWritable, DoubleWritable> {

@override
public void compute(ComputeContext<Text, DoubleWritable, NullWritable, DoubleWritable> context,
Iterable<DoubleWritable> messages) throws IOException {
if (context.getSuperstep() == @) {
setWalue(new DoubleWritable(1l.8 / context.getTotalNumvertices()));
} else if (context.getSuperstep() »>= 1) {
double sum = @;
for (DoubleWritable msg :

P L

messages) {

s > ODPS MapReduce|Graph,as follows.

= — ~ Eclipse = ==
File Edit Source Refactor Mavigate Search Project Run Window Help
Hmilg @ HB-O0-QR-WEIBE S F tHrCo ey Quick Access ;| B | &'
[# Package Explorer I3 Sl v= 8 Exampleja PageRankjava &2 = 8 = outline & =8
4 1% odps B 1 package com.aliyun.odps.examples. graph; - FPEEARY e W
® src “% inport java. io. T0Exceptions] & com.aliyun.odps.examples.graph
> mh JRE System Library [Java] 18 4 3, PageRank
> B Libaamad SEd E > (@° PageRankVertex
" ts:
Py} examp\?s‘ New L :é:”_::k;wt » OF PageRankVertexReader
4 i com.aliyu Open B m ° printUsage( : void
> 1] Kmea Open With N . @ ° main(String[]) : void
, () PageR geRank {
- Open Type Hierarchy F4
> [J) sSSP I AtsShiftew p | C1255 PageRankvertex extends
» 58 com.aliyu S0 el xt, DoubleWritable, NullWritable, DoubleWritables {
> i com.aliyu| [F] Copy Ctrl+C
> # comaliyu & Copy Qualified Name compute (ComputeContext<Text, DoubleWritable, NullWritable, DoubleWritable> context,
(= temp Paste Ctrlsy  fe<Doubletritable> messages) throws IOException {
4 = warehouse Ie] xt.getsuperstep() == @) {
. K Delete Delete  je(new DoubleWritable(1.8 / context.getTotalNumVertices()));
> (= example_ (context.getSuperstep() >= 1) {
Readme Remove from Context Ctrl+Al+Shift+Down  |sum = @;
Bardlpaih , fublenritable msg : messages) {
= msg.get();
Source Alt+Shift+S »
Refactor AltsShiftsT s Jritable vertexvalue =
Doublelritable((®.15f / context.getTotalNumVertices()) + 8.85f * sum);
9 Import.. e(vertexvalue);
5 Export.. v
References » on B Console 32 ~m-=8
Declarations * | this time.
& Refresh F5
Assign Working Sets...
Coverage As v
Run As »
+ | O 1Java Application Alt+Shift+D, J
Validate 4% 2 ODPS Mapreduce|Graph
Restore from Local History... Wr 3 ODPS UDFIUDTFUDAF
Team r .
X Debug Configurations...
Compare With »
Replace With »
com.aliyun.odps.examp Properties Alt+Enter 8

The dialog box appears, and configure it as follows.
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ODPS Mapreduce|Graph Run Configuration

Class

com.aliyun.odps.examples.graph.PageRank

Run Mode
@ Local Remote

Select ODPS Project

MySecondProject?

Remove

Resources

Program Arguments

|pagerank_in pagerank_out | -

@ | Enish || Caneel

View the running result,as follows.

Issue: 20190612 121



[£! Problems @ Javadoc (G, Declaration B Console &2 TR 1 &l

=terminated= PageRank [ODPS Mapreduce|Graph] Dv\Program Files'Javaljre\bin\javaw.exe (2018F12817H E411:45:54)

3

vertex edgs size: 2
4

2

3

vertex edgs size: 2
3

1

2

vertex edgs size: 2|
User defined counters: 4

com.aliyun.odps.graph.local. COUNTER
TASK_INPUT_BYTE=24
TASK_INPUT_RECORD=4
TASK_OQUTPUT_BYTE=88
TASK_OQUTPUT_RECORD=4
[INFO]Reload warehouse table:pagerank_out

graph task finish
Job Finished in 8.5 seconds

You can view the computing result on the local,as follows.

File Edit Navigate Search Project Run

[# Package Explorer &2 ISIR=Y | )
4 §% odps
& src
> @i JRE System Library [Java]
» @) Referenced Libraries
4 B examples
4 f3 com.aliyun.odps.examples.graph
> Kmeans.java
> PageRankjava
> S55P.java
> i com.aliyun.odps.examples.mr
» i com.aliyun.odps.examples.udf
> com.aliyun.odps.examples.udf.test
(= temp
4 (= example_project
» [ _resources__
4 [= _tables_
> (= kmeans_in
> (= kmeans_out
> = pagerank_in
> [= pagerank_out
» & rs_out
> £ sssp_in

= _schema__

= WorkSpace - odps/warehouse/example_project/_tables_fsssp_out/attempt_graph_20150106031645_507_4332_000000_0 - Eclipse
Window Help

- L@ i -0 U WO IS A G D

¥ =0 UDFExample,java PageRankjava |E] attempt_graph_20150106031645_507_4332_000000_0 i = 8

7| [

[2 Problems @ Javadac [&, Declaration B Cansale & I K %‘

<terminated > PageRank [ODPS Mapreduce|Graph] D:\Program Files\Java\jre\bin\javaw.exe (20185128178 £4F11:45:54)
3

vertex edgs size: 2

4

2

3

vertex edgs size: 2

attempt_graph_20150106031645_507| 3

|2| attempt_graph_20150109023801_237
> = we_inl

> (= we_in2
> = we_out
| Readme

attempt_graph_20150108122659_734 1

vertex edgs size: 2|
User defined counters: 4
com.aliyun.odps.graph.local .COUNTER

TASK_INPUT_BYTE=24
TASK_INPUT_RECORD=4
TASK_OQUTPUT_BYTE=88
TASK_OQUTPUT_RECORD=4

[INFO]Reload warehouse table:pagerank_out

graph task finish

Job Finished in 8.5 seconds

+ 4 n

After the debugging is complete, you can package the program and upload it to

MaxCompute as a Jar resource. Then submit Graph job.

@ Note:

- For the package process, see MapReduce Eclipse Plug-in Introduction.



- For the structure introduction of local result, see MapReduce Eclipse Plug-in

Introduction.

- For the detailed introduction of uploading Jar resource, see Add Resource in Basic

Introduction .

- For submitting the Graph job, see Graph Function.



4 Downloads

This document provides you with the download address of the relevant tools and
plugins.

- SDK Downloads: Maven users can search odps-sdk from Maven library to get

different versions of the Java SDK.

- MaxCompute client: Click here to download the new version of MaxCompute client.

- Eclipse plugin

- Intellid plugin, Studio

- JDBC

* PHP SDK


http://docs-aliyun.cn-hangzhou.oss.aliyun-inc.com/assets/attach/119118/cn_zh/1559120057202/odpscmd_public_May.zip
https://docs-aliyun.cn-hangzhou.oss.aliyun-inc.com/cn/odps/0.0.90/assets/download/odps-eclipse-plugin-bundle-0.16.0.zip
https://www.jetbrains.com/idea/?spm=5176.doc50891.2.4.2O5djt
https://plugins.jetbrains.com/plugin/9193-maxcompute-studio
https://github.com/aliyun/aliyun-odps-jdbc/releases
https://github.com/aliyun-beta/aliyun-odps-php-sdk
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